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1. PROIECTAREA MODELELOR VIRTUALE 

 Proiectarea asistată de calculator (Computer Aided Design - CAD) presupune crearea de modele 

computerizate definite de parametri geometrici. Aceste modele apar de obicei pe un monitor ca o 

reprezentare tridimensională a unei piese sau a unui sistem de piese, care poate fi ușor modificată prin 

modificarea parametrilor relevanți. Sistemele CAD le permit proiectanților să vadă obiecte într-o mare 

varietate de reprezentări și să testeze aceste obiecte prin simularea condițiilor din lumea reală. 

Procesele de fabricare asistate de calculator (Computer Aided Manufacturing - CAM) utilizează 

date de proiectare geometrică pentru a controla mașinile automate. Sistemele CAM sunt asociate cu 

sisteme de control numeric computerizat (CNC) sau control numeric direct (DNC). Aceste sisteme 

diferă de formele mai vechi de control numeric (NC) prin faptul că datele geometrice sunt codificate 

mecanic. Deoarece atât CAD cât și CAM folosesc metode bazate pe calculator pentru codificarea 

datelor geometrice, este posibil ca procesele de proiectare și fabricație să fie integrate. 

 

1.1.  Originile CAD 

 Proiectarea asistată de calculator își are originile în trei surse separate, care servesc și la 

evidențierea operațiunilor de bază pe care sistemele CAD le furnizează. Prima sursă de CAD a 

rezultat din încercările de automatizare a procesului de redactare. Aceste dezvoltări au fost inițiate de 

către General Motors Research Laboratories la începutul anilor 1960. Unul dintre avantajele 

importante ale modelării pe calculator față de metodele tradiționale de redactare este de economisire 

de timp și a faptului că modelele pot fi corectate sau manipulate rapid prin modificarea parametrilor. 

A doua sursă de CAD a fost testarea proiectelor prin simulare. Utilizarea modelării computerizate 

pentru testarea produselor a fost pionierată de industriile de înaltă tehnologie, cum ar fi industria 

aerospațială și semiconductoare. A treia sursă de dezvoltare CAD a rezultat din eforturile de a facilita 

fluxul de la procesul de proiectare la procesul de fabricație folosind tehnologii de control numeric 

(NC), care s-au bucurat de o utilizare pe scară largă în multe aplicații până la mijlocul anilor 1960. 

Această sursă a fost cea care a dus la legătura dintre CAD și CAM. Una dintre cele mai importante 

tendințe în tehnologiile CAD şi CAM este integrarea din ce în ce mai strânsă între etapele de 

proiectare și etapele de fabricație ale proceselor de producție bazate pe acestea. 

 Dezvoltarea CAD și CAM și în special legătura dintre cele două au depășit deficiențele 

tradiționale NC în ceea ce privește cheltuielile, ușurința de utilizare și viteza, permițând proiectarea și 

fabricarea unei piese să fie efectuate folosind același sistem de codificare a datelor geometrice. 

Această inovație a scurtat foarte mult perioada dintre proiectare și fabricație și a extins foarte mult 

domeniul de aplicare al proceselor de producție pentru care mașinile automate puteau fi utilizate 

economic. La fel de important, CAD şi CAM a oferit proiectantului un control mult mai direct asupra 

procesului de producție, creând posibilitatea proceselor de proiectare și producție complet integrate. 

 Creșterea rapidă a utilizării tehnologiilor CAD şi CAM după începutul anilor 1970 a fost posibilă 

prin dezvoltarea cipurilor de siliciu produse în masă și a microprocesorului, rezultând calculatoare mai 

ușor accesibile. Pe măsură ce prețul computerelor a continuat să scadă și puterea lor de procesare s-a 

îmbunătățit, utilizarea CAD şi CAM s-a extins de la firmele mari care foloseau tehnici de producție în 

masă la scară largă la firme de toate dimensiunile. Sfera operațiunilor la care s-a aplicat CAD s-a 

lărgit, de asemenea. Pe lângă modelarea pieselor prin procesele tradiționale ale mașinilor-unelte, cum 

ar fi ștanțarea, găurirea, frezarea și șlefuirea, CAD şi CAM a ajuns să fie utilizat de firmele implicate 

în producerea de electronice de larg consum, componente electronice, materiale plastice turnate și o 

serie de alte produse. Calculatoarele sunt, de asemenea, folosite pentru a controla o serie de procese 

de fabricație (cum ar fi procesarea chimică) care nu sunt definite strict de CAM, deoarece datele de 

control nu se bazează pe parametri geometrici. Folosind proiectarea asistată de calculator, este 

posibilă simularea în trei dimensiuni a mișcării unei piese printr-un proces de producție. Acest proces 

poate simula vitezele de avans, unghiurile și vitezele mașinilor-unelte, poziția clemelor de prindere a 

pieselor, precum și intervalul și alte constrângeri care limitează operațiunile unei mașini. Dezvoltarea 

continuă a simulării diferitelor procese de producție este unul dintre mijloacele cheie prin care 

sistemele CAD și CAM devin din ce în ce mai integrate. Sistemele CAD şi CAM facilitează, de 

asemenea, comunicarea între cei implicați în proiectare, producție și alte procese. Acest lucru este de 
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o importanță deosebită atunci când o firmă contractează o alta, fie pentru a proiecta, fie pentru a 

produce o componentă. 

 

 

1.2.  Avantajele și dezavantajele utilizării CAD 

 Modelarea cu sisteme CAD oferă o serie de avantaje față de metodele tradiționale de desenare 

care folosesc rigle, echere și compasuri. De exemplu, desenele pot fi modificate fără ștergere și 

redesenare. Sistemele CAD oferă, de asemenea, funcții de „zoom” similare lentilei unei camere, prin 

care un proiectant poate mări anumite elemente ale unui model pentru a facilita inspecția. Modelele 

computerizate sunt de obicei tridimensionale și pot fi rotite pe orice axă, la fel cum s-ar putea roti un 

model tridimensional real în mână, permițând proiectantului să obțină o percepție mai deplină a 

obiectului. Sistemele CAD se pretează și la modelarea desenelor secționate, în care este dezvăluită 

forma internă a unei piese și la ilustrarea relațiilor spațiale dintre un sistem de piese. 

 Pentru a înțelege proiectarea asistată de calculator, este de asemenea util să înțelegeți ce nu 

poate face CAD. Sistemele CAD nu au mijloace de a înțelege concepte din lumea reală, cum ar fi 

natura obiectului proiectat sau funcția pe care o îndeplinişte acel obiect. Sistemele CAD funcționează 

prin capacitatea lor de a codifica concepte geometrice. Astfel, procesul de proiectare folosind CAD 

implică transferul ideii unui proiectant într-un model geometric formal. Eforturile de dezvoltare a 

„inteligenței artificiale” (IA) bazată pe computer nu au reușit încă să pătrundă dincolo de mecanicul – 

reprezentat de modelarea geometrică (pe bază de reguli). 

Alte limitări ale sistemelor CAD sunt abordate de cercetarea și dezvoltarea în domeniul sistemelor 

expert. Acest domeniu este derivat din cercetările efectuate în IA. Un exemplu de sistem expert 

implică încorporarea de informații despre natura materialelor - greutatea acestora, rezistența la 

tracțiune, flexibilitatea și așa mai departe - în software-ul CAD. Prin includerea acestora și a altor 

informații, sistemul CAD ar putea „ști” ce știe un inginer expert atunci când acel inginer creează un 

design. Apoi, sistemul ar putea imita modelul de gândire al inginerului și de fapt „crea” mai mult din 

design. Sistemele expert ar putea implica implementarea unor principii mai abstracte, cum ar fi natura 

gravitației și frecarea, sau funcția și relația pieselor utilizate în mod obișnuit, cum ar fi pârghiile sau 

piulițele și șuruburile. 

Totuși, astfel de concepte futuriste depind în mare măsură de abilitățile noastre de a analiza 

procesele de decizie umane și de a le traduce în echivalente mecanice, dacă este posibil. 

 

1.3.  Clasificarea sistemelor CAD 

 Sistemele CAD pot fi clasificate din mai multe punte de vedere: 

 În funcție de domeniul de aplicare. Sistemele CAD sunt dezvoltate în toate zonele industriale, 

astfel încât putem găsi sisteme din domeniul ingineriei mecanice, inginerie electrică, proiectare 

arhitecturală, inginerie civilă, proiectare în domeniul textil, aplicații medicale. 

 În funcție de tipul modelării. Tipul modelării poate fi 2D, când reprezentarea piesei este similară 

cu desenul ingineresc, Figura 1.1 (A). Cealaltă metodă este modelarea 3D, când modelul piesei 

este construit în spațiul virtual, Figura 1.1 (B şi C). 

 În funcție de metoda de modelare aplicată:  

 Metoda wireframe, când sunt definite doar marginile piesei prin rețea de linii și curbe.  

 În cazul modelării suprafeței (surface design), modelul CAD este „gol”, se definește doar 

conturul exterior limită.  

 Modelarea solidă asigură o reprezentare realistă (part design), modelul este format din elemente 

elementare simple. 

 În cazul modelului parametric, dimensiunea modelului este determinată de parametrii 

geometrici. 
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Figura 1.1 

Modelarea wireframe  

 Un model wireframe descrie marginile care delimitează suprafețele obiectului modelat. Aceste 

margini pot consta din linii, arce și curbe. 

 Dezavantajele metodei de modelare: 

 toate marginile sunt afișate pe imaginea afișată; 

 vizibilitatea redusă, modelul afișat nu arată clar obiectul modelat; 

 caracteristicile de volum și masă nu pot fi specificate; 

 furnizarea datelor este lungă și dificilă; 

 nu se pretează pentru proiectarea formelor și specificarea formelor mai complexe. 

 Modelarea wireframe nu mai este practic utilizată astăzi ca metodă de proiectare. In orice caz, 

ea poate fi o etapă premergătoare, modelele wireframe sunt construite ca rețele suport pentru 

modelarea suprafețelor sau ca metodă de vizualizare, o imagine wireframe poate fi de ajutor în 

proiectarea modelului solid, Figura 1.2. 

 

Figura 1.2 

 

Modelarea suprafeţelor (Surface Design) 

 Modelarea suprafețelor vizează proiectarea unor părți de suprafață finite, contururi închise, care 

pot avea o formă liberă. Această metodă de modelare nu gestionează informații topologice. 

Suprafețele definesc doar forma exterioară a obiectului.  

A

B

C

A B
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 În exemplul prezentat în Figura 1.3 se pot observa etapele de proiectare necesare pentru obținerea 

unui solid prin acest tip de modelare în mediul CATIA V5. 

 Prima etapă este cea de modelare a schițelor 2D sau a curbelor 3D care stau la baza generării 

suprafețelor, exemple de funcții utilizate la modelarea curbelor 3D sunt: circle, helix, spline etc., 

Figura 1.3 (2). 

 Următoarea etapă este cea de realizare a suprafețelor. Acest lucru presupune utilizarea schițelor 

2D sau curbelor 3D realizate anterior; acestea sunt folosite ca profil de bază sau ca linii pentru ghidare 

și control (3). Se folosesc apoi operații secundare de cosmetizare a suprafețelor, prin tăiere sau unire 

(4). Ultima etapă este cea în care modelul realizat doar din suprafețe se transformă în solid, folosindu-

se comenzi de îngroșare sau de închidere din modulul „Part Design” (5). 

 

Figura 1.3 

 

Modelarea solidelor (Part Design) 

 Așa cum ansamblurile sunt alcătuite dintr-un anumit număr de piese individuale, la fel putem 

spune că modelarea unui solid presupune realizarea unui anumit număr de elemente individuale care 

par asamblate între ele. Această asamblare a elementelor este prezentată în Figura 1.4 și se poate 

realiza prin: 

 unirea (∪), combinând mulțimile de puncte a două solide discrete; 

 diferența (/), producând diferența a două seturi de puncte; 

 intersecția (∩), definind setul comun de punte în care se află ambele solide. 

Creare rețelei de 
curbe și linii, 

Wireframe design

2

Operații secundare 
de unire, tăiere etc.

4
Crearea 

suprafețelor

Crearea solidului în 
Part Design

3

5

Proiectarea unei 
piese în Generative 

Shape Design 

1

6
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Figura 1.4 

 Elemente individuale care alcătuiesc un solid poartă denumirea de „features” și sunt prezentate 

unele sub altele în arbore principal (specification tree, feature manager design tree). Aceste elemente 

individuale pot fi clasificate în: elemente care au la bază o schiță (sketch-based, boss/base) sau 

elemente de cosmetizare (dress-up, fillet, chamfer) 

 Elementele care au la bază o schiță sunt create pornind de la o schiță bidimensională, schița este 

transformată în solid 3D prin unul din procedeele prezentate în Figura 1.5: de extrudare (A), de 

revoluție (B), de umplere a unui spațiu urmărind o traiectorie (C) sau prin umplerea unui spațiu aflat 

între două secțiuni (D). 

 Elementele de cosmetizare se realizează direct pe modelul solid (fillet, chamfer, draft, shell), la 

fel și elementele de manipulare sau de multiplicare (translate, rotate, scale, mirror, pattern etc.). 

 

Figura 1.5 

 În Figura 1.6 – 1.8 sunt prezentate etapele de modelare ale unui model solid 3D pornind de la un 

desen 2D, se pot observa toate elementele individuale pe care le conține solidul în Figura 1.7. 

T1 - cub; 
T2 - cilindru

Unirea

T1∪T2

Diferența

T1/T2  

T2/T1  

Intersecția

T1∩T2

A B C D

A B C D
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Figura 1.6 

 

 

Figura 1.7 
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Figura 1.8 

Modelarea parametrică 

 Modelarea parametrică automatizează proiectarea modelelor și detectează erorile de definire a 

modelelor proiectate, rezultând astfel o productivitate maximă. De exemplu, se pot genera cu ușurință 

patru modele diferite de jante din același fișier part, rezultând astfel mai multe configurații, Figura 

1.9. 

 

Figura 1.9 

 Modelarea parametrică presupune definirea anumitor elemente pe care proiectantul le adaugă la 

un document, acestea pot fi: 

 Parametrii, sunt elemente ce pot fi definite prin valori numerice, prin relații sau prin corelarea cu 

date dintr-un fișier exterior. 

 Elementul „Design Table” conține informația dintr-un fișier exterior de tip MS Excel sau text, care 

constrânge un set de parametri. Fiecare coloană a tabelului defineşte valorile parametrilor, iar 

fiecare linie a tabelului defineşte o configurație a modelului proiectat. 

 Parametrii definiți de proiectant sunt folosiți pentru următoarele motive: 

 pentru a avea acces cât mai ușor la unele dimensiuni, în vederea modificării lor; 

 pentru centralizarea cât mai accesibilă a elementelor cheie, astfel încât proiectantul care este 

mai puțin familiarizat cu modelul, să îl înțeleagă cât mai ușor și rapid; 

 pentru a se ușura referirea la un parametru în timpul utilizării acestuia într-o relație; 

 Tabelul de parametrizare (Design Table) se utilizează în modelare pentru crearea și controlul 

familiilor de componente, componetelor standardizate (ca de exemplu piuliţa hexagonală cu filet 

A B C D
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metric SR EN ISO 4032:2013 din Figura 1.10), atunci când este nevoie să se construiască mai multe 

configurații pentru același model.  

 Un avantaj în modelarea parametrizată îl constituie faptul că este mult mai ușor să se intervină în 

modificarea valorilor parametrilor care definesc modelul. 

 

Figura 1.10 

 

1.4.  Planul de proiectare (Design Intent) 

 Modelul solid al unei piese trebuie să aibă un plan de proiectare pentru a transmite în mod 

corespunzător aspectele sale vizuale şi funcţionale. Pentru a utiliza un modelator parametric aşa cum 

este CATIA, proiectantul trebuie să creeze un plan de modelare cu tehnici de proiectare înainte, dar şi 

în timpul modelării piesei. Tehnicile de proiectare utilizate pentru a crea modelul pot afecta modul în 

care acesta se comportă atunci când este modificat în timpul ciclului său de viaţă.  

 Modul în care este construit un model solid poate afecta multe aspecte, inclusiv flexibilitatea 

acestuia la schimbare, stabilitatea sa în timpul procesului de schimbare şi resursele de care are nevoie 

pentru a calcula noul rezultat. Prin urmare, este important să se ţină cont şi să se realizeze un plan de 

modelare care să proiecteze un model eficient al piesei.  

 În planul de proiectare trebuie să se ţină cont de următoarele elemente: 

- Relaţiile automate (implicite): în funcţie de modul în care este schiţată geometria unui profil, 

aceste relaţii automate creează relaţii geometrice comune între obiecte, cum ar fi: tangenţă, 

paralelism, perpendicularitate, veriticalitate şi orizontalitate. 

- Ecuaţiile: ecuaţiile sunt utilizate pentru a defini dimensiunile modelul algebric, ele oferă o 

modalitate externă de a forţa schimbările. 

- Relaţiile suplimentare: relaţiile care sunt definite în timpul proiectării modelului oferă o altă 

modalitate de a conecta geometria aferentă, o parte din relaţii din această categorie sunt: 

concentricitate, tangenţă, coincidenţă şi coliniaritate. 

- Dimensionare: felul în care o schiţă este dimensionată influenţează planul de proiectare. 

Dimensiunile trebuie adaugate astfel încât să reflecte modul în care se doreşte modificarea 

ulterioară a lor, dar controlând totodată elementele din schiţă. 

 Exemplul prezentat în Figura 1.11 arată diferite planuri de proiectare pentru aceeaşi schiţă, 

aceasta realizează o placă cu lungimea de 100mm şi 2 găuri. Cum ar fi afectată geometria schiţei dacă 

s-ar modifica lungimea plăcii, acea cotă de 100mm să se mărească la 200mm, pentru fiecare caz in 

parte? 

A B C
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Figura 1.11 

 Profilul dimensionat ca în Figura 1.11 (A) ar păstra poziţia găurilor la distanţa de 20mm faţă de 

fiecare muchie, mai aproape de fiecare muchie, în timp ce placa s-ar alungi până la 200mm.  

 În cazurile prezentate în figurile (B) şi (C) găurile ar rămâne poziţionate mai aproape de muchia 

din stânga, poziţia lor nu ar fi afectate de alungirea plăcii până la 200mm. Dar dacă s-ar schimba cota 

de 20mm de la marginea plăcii, ar rămâne neafectată doar distanţa găurilor a căror centre au fost 

cotate, aşa cum se observă în figura (C), distanţa dintre găuri nu se modifică. 

 Planul de proiectare mai poate fi afectat, nu doar de modul în care este dimensionată o schiţă, ci 

şi de modul în care elementele simple (features) alcătuiesc piesa. De exemplu, pentru a modela 

arborele din Figura 1.12, care are un anumit număr de tronsoane cu diametre şi lungimi diferite, se 

poate utiliza una din metodele de proiectare prezentate mai jos: 

 

Figura 1.12 

- Se poate proiecta primul tronson cu diametrul şi lungimea corespunzătoare, apoi se creează 

următorul tronson şi aşa mai departe, până când se obţine forma finală a arborelui, Figura 1.13; 

Modificându-se lungimea sau diametrul primului tronson poate creea un efect în „cascadă”, 

deoarece se modifică poziţia iniţială a celorlalte tronsoane care au fost create după acesta. 

 

Figura 1.13 

A B C

a b c d e
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- Se poate proiecta un profil care să conţină toate diametrele şi lungimile tronsoanelor într-o 

singură schiţă, iar acest profil să se rotească în jurul unei axe transversale rezultând astfel forma 

finală a arborelui, Figura 1.14. Chiar dacă această abordare poate părea cea mai eficientă, a avea 

toate informaţiile de proiectare într-o singură schiţă poate limita flexibilitatea modelului, iar 

modoficările se pot realiza cu dificultate într-o schiţă complexă sau încărcată cu multe elemente 

şi cote. 

 

Figura 1.14 

- Se poate proiecta arborele imitând modul prin care tronsoanele ar fi realizate prin procesul 

tehnologic de strunjire. Se porneşte de la o bucată întreagă de semifabricat care are un diametru 

mare şi se îndepărtează treptat material print-o serie de decupări prin aşchiere, până când rezultă 

forma finală a arborelui, Figura 1.15. 

 

Figura 1.15 

 Modurile de proiectare prezentate sunt diferite, dar nu se poate spune care abordare este corectă 

sau greşită, programul CATIA oferă o flexibilitate mare în proiectare, iar modificările asupra 

modelelor se pot realiza destul se simplu. Dar dacă proiectantul realizează modele cu planul de 

proiectare ale acestora în minte, poate creea documente uşor de modificat şi de reutilizat pentru alte 

proiecte, uşurânduşi ulterior munca. 

 

a b c d
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2. PROIECTAREA SCHIŢELOR 2D ÎN CATIA V5 

CATIA V5 este un software de proiectare utilizat în domeniul ingineriei mecanice. Este un 

instrument parametric de modelare a corpurilor solide utilizând interfața grafică a sistemului de 

operare Windows. Programul CATIA V5 furnizează o varietate largă de soluții integrate pentru a 

satisface toate aspectele legate de design și fabricație. Dintre numeroasele funcționalități de bază se 

pot aminti: concepția avansată a pieselor mecanice, realizarea interactivă a ansamblurilor, obținerea 

automată a proiecțiilor pieselor, posibilitatea de a proiecta în mod parametrizat etc. 

CATIA are o structură modulară, trecerea de la un modul la altul se face ușor, cu posibilitatea de 

editare continuă a modelelor aflate în lucru, fără pierdere de informație.  

Toate operațiunile parcurse în acest capitol se desfășoară în modulul de lucru Mechanical 

Design, de sub START, așa cum se poate vedea în Figura 2.1 (1). Prin lanțul de comenzi START -> 

Mechanical Design se poate intra în unul dintre modulele: Part Design, Assembly Design, Sketcher 

etc.  

 
Figura 2.1 

 

Sketcher este modulul în care se creează schița unui profil în două dimensiuni, fiind un punct de 

plecare în procesul de obținere a unui obiect 3D. Part Design este modulul în care se proiectează piese 

sub formă solidă 3D. Assembly Design este modulul în care se asamblează piesele prin constrângeri 

mecanice pentru poziționarea acestora.  

În Figura 2.2 se poate observa interfața programului CATIA V5, modulul Part Design: 

A. START - meniul cu module; 

B. Arborele de specificații ; 

C. Pictograma specifică modulului activ; 

D. Bare cu comenzi specifice modulului activ; 

E. Bara cu comenzi standard;  

F. Compasul; 

G. Zona grafică de lucru.  

1

2
3
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Figura 2.2 

Barele de instrumente sunt deplasabile, existând posibilitatea poziționării lor personalizate în 

interfață. Implicit, barele se află în locurile prestabilite din dreapta și de jos a ecranului de lucru.  

Identificarea, selectarea și afișarea barelor de instrumente suplimentare se face prin click dreapta 

al mouse-ului pe oricare altă bară de instrumente, iar din lista apărută se bifează numele barei de 

instrumente dorite. Pentru a aduce barele la poziția lor implicită, se alege din aceeași listă cu 

instrumente Customize…, se deschide o fereastră din care se alege tab-ul Toolbars și se apasă pe 

butoanele Restore all contents și Restore position. 

 

2.1.  Crearea schițelor 

Piesele realizate într-un program CAD pot fi alcătuite din trei tipuri de elemente constructive: 

- elemente bazate pe schițe; 

- elemente care nu au nevoie de o schiță; 

- elemente derivate.  

 Majoritatea elementelor de bază care sunt realizate în mediul CATIA se bazează pe o schiță 

bidimensională, Figura 2.3. Aceste schițe sunt realizate cu uneltele din modulul Sketcker. 

 

Figura 2.3 

Pentru a realiza o nouă schiță este necesar un suport.  
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Suportul unei schițe trebuie să fie un plan. Se poate crea o schiță pe un plan de bază, pe un plan 

de referință definit, pe fața plană a unui solid sau pe o suprafață plană individuală. 

De obicei, schița primului element (feature) este creată pe unul din planele de bază: 

A. planul XY;  

B. planul YZ;  

C. planul ZX.  

Orientarea implicită a modelului se face în funcție de 

planul de referință selectat pentru suportul schiței de bază. 

Planul XY este considerat planul vedere frontală a 

modelului. 

Alegerea suportului pe care se realizează schița se face în funcție de orientarea piesei în raport cu 

sistemul de coordonate sau de locul unde trebuie realizat un element pe piesă. De exemplu, așa cum se 

poate observa și în Figura 2.4., se selectează planul de bază ZX dacă se dorește crearea unui profil 

lateral.  

 

Figura 2.4 

 

Tipuri de schițe 

Există două tipuri de schițe: Sketch, , și Positioned Sketch, . Comanda Sketch permite 

realizarea unei schițe a cărei orientare este dependentă de sistemul global de coordonate și nu poate fi 

modificată. În schimb, pentru o schiță realizată cu Positioned Sketch este permisă modificarea 

orientării sistemului absolut de axe în raport cu sistemul global de coordonate. 

Pentru a crea o schiță de tipul Sketch se parcurg următorii pași:  

1. Se selectează un plan suport pentru schiță; 

2. Se selectează comanda Sketch din bara de lucru, care se află în partea dreaptă a ferestrei, sau 

urmând traseul: Start -> Mechanical Design -> Sketcher; 

3. CATIA deschide spațiul de lucru pentru schițe cu instrumentele specifice modulului 

Sketcher, Figura 2.5 (3). 

Orice schiță are definit un sistem absolut de coordonate, Absolute Axis, caracterizat de trei 

elemente: 

- H Direction - direcția paralelă cu axa orizontală și simbolizată cu H; 

- V Direction - direcția paralelă cu axa verticală și simbolizată cu V; 

- Origin - originea, aflată la intersecția celor două axe. 

Profilul schiței  
pe planul XY

Profilul schiței  
pe planul YZ

Profilul schiței  
pe planul ZX
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Figura 2.5 

Pentru a deschide o schiță de tipul Positioned Sketch se parcurg următorii pași: 

1. Se selectează comanda Positioned Sketch. 

2. Apare o nouă fereastră cu opțiunile acestui tip de 

schiță: 

a. Schița are ca suport planul de referință selectat. 

b. Se modifică opțiunile pentru schimbarea originii. 

c. Se modifică opțiunile pentru schimbarea orientării 

axelor. 

d. Schimbarea sensului axei H și axei V sau a 

inversării lor între ele (Swap). 

3. CATIA deschide spațiul de lucru pentru schițe cu 

instrumentele specifice modulului Sketcher. 

 

Suportul unei schițe poate fi modificat prin accesarea 

meniului contextual al schiței respective. (click dreapta pe 

denumirea schiței Sketch.x -> Change Sketch Support). Se 

deschide tot fereastra Sketch Positioning, în care se pot 

realiza noile modificări. 

Pentru modelarea pieselor se recomandă utilizarea 

schiței de tip Positioned Sketch , deoarece are un grad mai 

mare de control și se pot modifica ușor proprietățile ce țin 

de suport, origine și orientarea axelor. 

 

Bara Sketch Tools 

 Odată ce s-a intrat în modulul Sketcher pentru a se realiza schița de bază, se poate observa pe 

mijlocul ecranului bara Sketch Tools. Aceasta conține o serie de comenzi predefinite (cele prezentate 

mai jos) dar și diverse proprietăți care devin disponibile la activarea altor comenzi de construcție sau 

modelare a profilelor. 

 

Bara Sketch Tools cuprinde următoarele comenzi:  

A. Grid - activarea rețelei plane;  

B. Snap to Point - trecerea prompterului din nod în nod de rețea;  

C.  Construction/Standard Element - trecerea de la un element de construcție la un element 

standard; 

1
2

3
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D.  Geometrical Constraints - aplicarea automată a constrângerilor geometrice; 

E. Dimensional Constraints - aplicarea automată a constrângerilor dimensionale. 

O comandă este activă dacă este reprezentată prin culoarea portocalie. 

În Figura 2.6 se poate observa utilizarea comenzii Snap to Point. 

 

Figura 2.6 

Când această comandă este activată, capetele elementelor sunt prinse de nodurile de rețea, iar când 

comanda este inactivă, capetele elementelor pot fi plasate și în spațiul dintre liniile rețelei. 

Elementele de construcții se utilizează într-o schiță pentru a ajuta la crearea profilului. 

Elementele de construcție sunt reprezentate prin linie punctată și nu sunt luate în calcul ca făcând 

parte din profilul schiței. 

Atâta timp cât butonul Construction/Standard Element este activ, toate elementele create sunt 

elemente de construcție. În Figura 2.7 sunt prezentate elemente standard de tip cerc transformate în 

elemente de construcție cu ajutorul comenzii Construction/Standard Element. 

 

Figura 2.7 

Snap to Point 
inactiv

Snap to Point 
activ

Elemente de construcție 
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Dacă butoanele Geometrical Constraints (A) și Dimensional Constraints (B) din bara Sketch 

tools sunt activate în timpul construcției unui profil într-o schiță, se creează automat o serie de 

constrângeri geometrice sau dimensionale. 

 
Aceste unelte sunt utile pentru geometrii simple, deoarece ajută la creșterea vitezei de finalizare a 

profilului. Pentru profiluri cu geometrii complexe este recomandat să nu fie selectate aceste comenzi, 

deoarece aceste unelte pot adăuga constrângeri nedorite, iar îndepărtarea lor poate crește timpul de 

finalizare a profilului final. 

 

2.2.  Comenzi pentru construcția profilelor  

Pentru a realiza un element (feature) în CATIA, este necesar ca profilul desenat să fie un contur 

închis, iar elementele acestuia nu trebuie să se suprapună. Acest profil poate fi realizat utilizând 

comenzile din bara Profile. Pe această bară, se întâlnesc funcții care permit crearea de puncte, linii, 

cercuri, arce de cerc sau contururi închise predefinite (dreptunghiuri, găuri alungite drepte sau curbe, 

hexagon, paralelogram etc.) 

 

A. Profile - permite desenarea unui profil închis sau deschis; 

B. Predefined Profile - construcție bazate pe poligoane; 

C. Circle - comenzi bazate pe cercuri; 

D. Spline - construcții bazate pe linii spline; 

E. Conic - comenzi pentru elipse, parabole și hiperbole 

F. Line - comenzi pentru diverse tipuri de linii; 

G. Axis - linii de axe; 

H. Point - comenzi pentru definirea punctelor în plan. 

 

A. Comanda Profile  

 O variantă de trasare a profilului în „timp real” o reprezintă utilizarea comenzii Profile. Pe 

măsură ce este trasat profilul, programul CATIA asistă procesul de desenare oferind proiectantului 

diferite constrângeri, relative la diferite elemente ale profilului. 

 În Figura 2.8 sunt prezentați pașii necesari pentru trasarea unui profil, contur închis, utilizând 

comanda Profile:  

1. Se selectează butonul Profile; 

2. Se așează cursorul în spațiul de lucru și printr-un click se stabilește punctul de început; 

3. Se trasează o linie orizontală spre stânga; 

4. Se selectează de pe bara Sketch tools comanda Tangent Arc (arc tangent); 

5.  Se creează arcul de cerc; 

6. Comanda Profile revine la starea inițială de linie (Line), se creează o altă linie orizontală; 

7. Se trasează linia verticală; 

8. Se realizează cea dea 3-a linie orizontală; 

9. Se închide profilul printr-o linie înclinată. 

A B

A B C D E F G H
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Figura 2.8 

Comenzile de pe bara Predefined Profile permit utilizarea unor profile predefinite în construirea 

unei schițe. Se pot construi dreptunghiuri prin indicarea fie a două puncte diagonal opuse (Rectangle), 

fie prin indicarea a trei puncte reprezentând punctele din colţuri (Oriented Rectangle). Tot prin 

indicarea a trei puncte se poate construi și un paralelogram, punctele indicate formează două dintre 

laturile acestuia.  

Se mai pot construi contururi ale unor găuri alungite drepte (Elongated Hole) sau curbe 

(Cylindrical Elongated Hole), acestea pot fi create prin trei, respectiv patru puncte în spațiul de lucru, 

primele puncte definesc distanța dintre centre, iar ultimul punct determină lățimea găurii. 

Un alt contur care mai poate fi realizat este cel asemănător unei găuri de cheie (Keyhole), pentru 

obținerea acestui contur se precizează punctul care definește centrul razei mari și centrul razei mici, 

apoi se definește printr-un alt punct raza mică şi respectiv raza mare. 

Pentru a se realiza un hexagon este necesar să se definească centrul acestuia, apoi un punct de pe 

o latură și orientarea lui. 

Ultimele două comenzi de pe bara Predifined Profile sunt utilizate pentru contururi care sunt sub 

formă de dreptunghi sau de paralelogram, se definește prima dată punctul centrului de greutate și apoi 

lățimea și lungimea lor. 

B. Predefined Profile  

a. Rectangle; 

b. Oriented Rectangle; 

c. Parallelogram; 

d. Elongated Hole; 

e. Cylindrical Elongated Hole; 

f. Keyhole; 

g. Hexagon; 

h. Centered Rectangle; 

i. Centered Parallelogram. 

 

Trasarea cercurilor și a arcelor de cerc într-o schiță se realizează cu funcțiile de pe bara Circle. 

Se pot trasa cercuri definite printr-un punct de centru și o rază, prin unirea a trei puncte, prin 

impunerea coordonatelor sau prin impunerea entităţilor la care cercul trebuie să fie tangent. 

Se pot trasa arce de cerc care unesc trei puncte sau pentru care se cunoaşte poziţia centrului și 

raza. 

C. Circle  

a. Circle; 

b. Three Point Circle; 

c. Circle by Coordonates; 

d. Tri-Tangent Circle; 

e. Three Point Arc; 
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f. Three Point Arc Starting With Limits; 

g. Arc. 

 

Liniile curbe pot fi: elipse, parabole, hiperbole, conice sau de tip spline. 

D. Spline  

a. Spline; 

b. Connect. 

 

E. Conic  

a. Ellipse; 

b. Parabola by Focus; 

c. Hyperbola by Focus; 

d. Conic. 

Trasarea liniilor într-o schiță se realizează cu ajutorul 

comenzilor corespunzătoare de pe bara Line. 

Liniile drepte pot fi: simple finite, simple care tind la infinit, tangente, bisectoare sau perpendiculare 

la o curbă.  

F. Line 

a. Line; 

b. Infinite Line; 

c. Bi-Tangent Line; 

d. Bisecting Line; 

e. Line Normal to Curve. 

 

2.3.  Cotarea și constrângerea schițelor 

Odată ce a fost realizată geometria schiței, aceasta se poate constrânge din punct de vedere 

dimensional și din punct de vedere geometric. Constrângerile ajută la fixarea matematică a geometriei 

în spațiu. Fără restricții, elementele profilului se pot muta accidental cu cursorul. Dacă schița este 

modificată, atunci și solidul este predispus la modificări nedorite. Deci, fără constrângeri, elementele 

care urmează să fie create sunt imprevizibile și pot suferi modificări care afectează forma, încadrarea 

sau funcționalitatea unui întreg ansamblu.  

Definirea completă a unei schițe, adică a unui contur închis, necesită impunerea unor constrângeri 

dimensionale (cote) și a unor constrângeri de poziție relativă între elemente sau față de origine. Aceste 

constrângeri se pot realiza folosindu-se următoarele comenzi, din bara Constraint: 

 
A. Constraint Defined in Dialog Box (comanda devine activă după selectarea elementelor, se pot 

selecta unul, două sau trei elemente în funcție de situație); 

B. Constraint. 

În mod ideal, o schiță ar trebui să fie constrânsă complet           (fully-constrained). Dimensiunea 

și poziția în spațiu a unei schiței ar trebui să fie definite foarte clar. O schiță care nu este constrânsă 

complet (under-constrained) poate să nu își mențină forma dorită atunci când se fac modificări asupra 

modelului. 

Starea constrângerilor unei schițe este indicată printr-un cod de culoare, profilul din schiță așa 

cum se arată și în Figura 2.9 poate fi: 

A. Verde, culoarea verde indică o schiță definită complet. Geometria este fixată și nu își poate 

modifica dimensiunea, decât prin modificarea valorică a cotelor (Iso-constrained) 

A B

E

a b c d

F

a b c d e

D

a b



 

27 

 
B. Alb, culoarea alb indică o schiță care nu este definită complet dimensional sau pozițional 

(Under-constrained). 

C. Violet, culoarea violet indică o schiță supra-constrânsă             (Over-constrained), sunt prea 

multe cote sau relații geometrice. 

D. Roșu, culoarea roșu sau vișiniu indică o schiță cu constrângeri incorecte, apar conflicte de ordin 

geometric între constrângeri. Schița nu se poate realiza folosind dimensiunile și constrângerile 

indicate (Inconsistent). 

 

Figura 2.9 

 Constrângerile geometrice care se pot adăuga cu ajutorul comenzii Constraint Defined in 

Dialog Box sunt: 

- Constrângerea de fixare (Fix), se realizează pentru un element care trebuie să nu se 

mai poată deplasa. 

- Constrângerea de coincidență (Coincidence), se realizează între un punct care 

aparține de un element și un alt punct de pe un al element. 

- Constrângerea de concentricitatea (Concentricity), se realizează între două arce de 

cerc sau două cercuri care au originea comună. 

- Constrângerea de tangență (Tangency), se realizează între două elemente care 

pot fi tangente unul față de celălalt.  

- Constrângerea de paralelism (Parallelism), se realizează între două linii care 

trebuie să fie paralele. Se selectează prima dată linia care trebuie să rămână 

nemișcată și abia apoi se selectează linia care trebuie să fie paralelă cu prima.  

- Constrângerea de perpendicularitate (Perpendicularity), se realizează între două 

linii care trebuie să fie perpendiculare una față de alta. 

- Constrângerea de orizontalitatea (Horizontal), se realizează pentru o linie care 

trebuie să devină orizontală, adică paralelă cu axa H din schiță.  

- Constrângerea de verticalitatea (Vertical), se realizează pentru o linie care trebuie 

să devină verticală, adică paralelă cu axa V din schiță. 

- Constrângerea de simetrie (Symmetry), se realizează între două linii care sunt 

așezate simetric față de un al treilea element. Se selectează prima dată liniile 

care se doresc a fi simetrice și abia apoi elementul față de care se dorește 

simetria.  

 

 

A B

C D
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Constrângerile dimensionale care se pot adăuga cu ajutorul comenzii Constraint sunt: 

- cotarea unei raze sau a unui diametru (Radius/Diameter); 

- cotarea unui unghi dintre două linii neparalele (Angle); 

- cotarea unui element de tip lungime (Length); 

- cotarea distanței dintre două elemente (Distance); 

Este recomandat ca o schiță să fie complet constrânsă dimensional și geometric atât în raport cu 

sistemul absolut de axe, cât și cu elemente geometrice individuale. 

 

Recomandări pentru constrângeri 

 Profilul de bază al unui element (feature) ar trebui construit cu ajutorul comenzilor din bara 

Profile având forma și dimensiunile cât mai apropiate de schița finală, Figura 2.10 (1a). O schiță care 

este mult diferită de schița finală este o schiță greu de constrâns, fiind dispusă la deformări și greu de 

corectat (1b). După realizarea profilului aproximativ al schiței de bază, se recomandă realizarea 

constrângerilor geometrice (ex.: tangența, perpendicularitatea etc.) între elementele individuale și abia 

apoi dimensionarea lor (cotarea) (2). 

 

Figura 2.10 

Se recomandă să se utilizeze metoda prezentată în Figura 2.11 pentru realizarea constrângerilor 

atât pentru cele dimensionale (2a), cât și pentru cele geometrice (2b), deoarece este o metodă mult mai 

rapidă.  

 

Figura 2.11 

Dar nu este greșit dacă se utilizează comenzile Constrains și Constraint Defined in Dialog Box 

pe rând, pentru fiecare constrângere în parte. 

 Când se creează o constrângere dimensională a unui profil, direcția cotelor este determinată de 

tipul elementelor selectate. Dacă elementele sunt puncte sau cercuri, direcția predefinită a cotelor este 

paralelă cu linii care trec prin puncte sau prin centrele cercurilor, Figura 2.12 (1a) și (2a). Se pot 

modifica direcțiile cotelor, astfel încât acestea să fie așezate așa cum ne dorim, prin click dreapta în 

spațiul de lucru și selectând din meniul afișat, o direcție orizontală sau verticală față de sistemul de 

axe (1b) și (2b). 

Profilul de bază a 
schiței aproximative

Profilul de bază a 
schiței finale

21a 1b

Dublu-Click

Se selectează elementele 
geometrice pentru a fi 
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Figura 2.12 

Este recomandat să nu se folosească elementele de cosmetizare (Dress-up features) în construcția 

altor schițe, deoarece unele procese de fabricație necesită îndepărtarea, dezactivarea sau rearanjarea 

lor în arborele de specificații (Specification Tree), iar acest lucru ar duce la modificarea schițelor. De 

exemplu în Figura 2.13, în schița Sketch.4 este un arc de cerc concentric la muchia racordată 

EdgeFillet.1 (1). Dacă elementul EdgeFillet.1 este dezactivat sau șters, schița Sketch.4 are o eroare 

(2). 

 

Figura 2.13 

 Schema de prioritate a elementelor selectate și utilizate în contextul unei schițe poate fi 

reprezentată de:  

- elementele fixe (cum ar fi planele XY,YZ și ZX); 

- alte elemente din schiță; 

- suprafețele corpurilor 3D.  

 Dacă se constrânge o schiță de muchia unui solid așa cum se arată în Figura 2.14 (1), în modul de 

vizualizare perpendicular pe plan (normal view), CATIA realizează constrângerea cu prima muchie 

(2). O alternativă mai bună ar fi să se rotească schița și să se constrângă față de un element mai stabil, 

cum ar fi suprafața solidului și nu muchia acestuia (3). Se recomandă totuși, pe cât posibil, să se evite 

selectarea muchiilor corpurilor 3D. Odată ce s-a selectat elementul dorit, se apasă comanda Normal 

View, , pentru a se reveni la orientarea ecranului paralel cu suportul schiței. 

2a

2b

1a

1b

1 2
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Figura 2.14 

 

2.4.  Operații de editare a schițelor plane 

 Toate cele expuse până în prezent cu referire la schițele plane, se referă mai ales la noțiuni de 

construcție a contururilor plane, cu care se operează ulterior în spațiul 3D virtual. Operațiile de editare 

sunt destinate modificărilor contururilor deja trasate, pentru a le apropia de aspectul dorit. 

 Bara pe care CATIA o pune la dispoziția utilizatorului, în acest scop este Operation, cu mai 

multe opțiuni ulterioare. 

 

A. Corner - racordarea între două drepte; 

B. Chamfer - realizarea unui șanfren între două drepte; 

C. Relimitations 

a. Trim; 

b. Break; 

c. Quick Trim; 

d. Close; 

e. Complement; 

D. Transformation 

a. Mirror; 

b. Symmetry; 

c. Translate; 

d. Rotate; 

e. Scale; 

f. Offset; 

E. 3D Geometry 

a. Project 3D Elements; 

b. Intersect 3D Elements; 

c. Project 3D Silhouette Edges. 

 

 Prima comandă este Corner, . Opțiunea conduce la racordarea a două linii concurente, chiar 

dacă acestea nu se intersectează vizibil. Activarea comenzii Corner are ca urmare modificarea barei 

de control Sketch Tools, care capătă aspectul din Figura 2.15 (2) și enumeră posibilitățile de realizare 

a racordării prin: eliminarea liniilor care defineau vârful; prin eliminarea uneia dintre linii; prin 

menţinerea liniilor laturilor; prin înlocuirea unei linii standard cu o linie de construcţie şi prin 

înlocuirea ambelor linii standard cu linii de construcţie. După activarea opţiunii Corner, şi alegerea 

opţiunii din Sketch Tools, urmează selectarea celor două linii şi impunerea, pe ecran, a razei. Prin 

dublu click pe valoarea afișată a razei, această valoare poate fi modificată în caseta Constraint 

Definition.  

 Racordări pot fi realizate între laturi ale poligoanelor dar și între arce de cerc, arce de elipsă, 

curbe conice și curbe spline. 
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Figura 2.15 

 Utilizarea comenzii Chamfer, , (tot din Operation) conduce la realizarea teșiturilor. 

Algoritmul este foarte asemănător celui folosit la Corner: se activează comanda, apoi se selectează 

cele două linii (un exemplu este prezentat de Figura 2.16). Bara Sketch Tools se modifică așa cum 

apare în Figura 2.16 (4), pentru a opta pentru ștergerea liniilor inițiale, pentru menținerea uneia, a 

ambelor etc. Editarea valorii celor două cote se face ca și la Corner (5 - 7). 

 

Figura 2.16  

 Îndepărtarea unei porțiuni nedorite dintr-un element reprezentat în schiță necesită activarea 

comenzii Trim, , din Relimitation, care este bară sub Operation (sau se poate utiliza traseul: Insert 

-> Operation -> Relimitation -> Trim). Tăierea are loc prin delimitarea cauzată de intersecţia 

entităţilor plane. Activarea comenzii este însoţită de apariţia opţiunilor suplimentare din Sketch Tools: 

tăierea tuturor elementelor (Trim All Elements) sau tăierea primului element selectat (Trim First 

Element). Se trasează, prin urmare porțiunea care trebuie menținută. Limitele operaţiei sunt dictate de 

puncte de capăt şi de puncte de intersecţie, Figura 2.17. 
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Figura 2.17 

 Dacă se doreşte separarea (ruperea) unei entităţi în mai multe părţi, se poate apela la opţiunea 

Break, , tot din Relimitation.  

 Astfel, pentru conturul deschis din Figura 2.18 (B), s-a apelat la Break, , apoi s-a selectat (ca 

element ce trebuie rupt) linia, după care s-a selectat arcul de elipsă. Prin selectare, după operație, se 

observă că linia a fost împărțit în două, punctul de rupere fiind cel de intersecție din partea superioară 

a arcului. 

 Quick Trim, , este comanda utilizată frecvent pentru a tăia elemente ale contururilor schițate. 

Figura 2.19 cuprinde un exemplu de aplicare a comenzii, în care este prezentat conturul multiplu care 

trebuie tăiat. Prin dublu click pe Quick Trim, , pentru a se realiza mai multe operații înlănțuite, iar 

apoi se selectează pe rând, fiecare element (linii și arce) a conturului (3). Pe rând, aceste elemente 

dispar. 

 

Figura 2.18 

 Tăierea este limitată de punctele de intersecție, dar pot fi eliminate și elemente întregi, dacă 

acestea nu intersectează alte elemente schițate. Rezultatul este cel din Figura 2.19 (4). În acest caz, 

bara Sketch Tools oferă trei alternative: fragmentare și ștergere a elementului interior; fragmentarea 

elementului selectat şi eliminarea zonelor exterioare şi fragmentarea dar păstrarea tuturor porţiunilor 

obținute. 
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Figura 2.19 

 Comanda Close,  este utilizată la completarea contururilor de tip cerc sau elipsă, dacă au fost 

create inițial doar arce de cerc sau de elipsă. Comanda nu se referă la contururi formate din linii drepte 

și nici curbelor Spline.  

 Ultima opţiune dintre cele cuprinse în Relimitation (din Operation) este Complement, , care 

creează arcul complement al unui arc deja trasat.  

 Alte operații de editare sunt cuprinse în şirul Transformation de sub Operation (se poate utiliza și 

traseul: Insert -> Operation -> Transformation).  

 Mirror,  este comanda prin care se poate realiza simetricul unui element (evident plan) față 

de o axă definită de utilizator, Figura 2.20. Utilizarea comenzii impune inițial selectarea elementelor a 

cărui imagine multiplicată este obținută, apoi activarea lui Mirror din bara grafică Operation sau pe 

traseul Insert -> Operation -> Transformation -> Mirror (2). Ultimul element selectat este axa (linie 

de construcție, linie de axă sau o latură liniară a unui poligon). Această axă poate fi, de asemenea, una 

dintre axele sistemului de coordonate legat de planul de schiţare, o axă trasată de proiectant cu Axis, 

, sau orice linie dreaptă selectată de pe ecran (3). Automat apare imaginea oglindită a conturului 

selectat drept obiect al multiplicării.  

 

Figura 2.20 

 Tot sub Operation, Transformation se găsește comanda Symmetry, . Modul de acțiune al 

comenzii și modul de utilizare sunt identice cu cele menționate la Mirror, cu diferența că la Symmetry 

obiectul-sursă (cel supus simetriei) nu mai apare în noua imagine. 

 Pentru deplasarea unui element plan în lungul unei direcții, se folosește comanda Translate, , 

(sau pe traseul: Insert -> Operation -> Transformation -> Translate), când nu se activează opțiunea 
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Duplicate Mode. De fapt comanda Translate este complexă: are şi efectul multiplicării liniare, în plan. 

În acest mod de lucru, funcționarea comenzii poate fi urmărită în Figura 2.21. S-au selectat toate 

elementele care alcătuiesc pătratul cu latura de 20mm. După activarea comenzii Translate, se 

deschide caseta de dialog Translation Definition, în care se completează numărul de copii dorite 

(Instance: 3) și se activează opțiunile Duplicate Mode și Keep internal constraints, Keep external 

constraints (dacă se dorește copierea constrângerilor interne și externe, (4)). Pentru a se putea defini 

pasul de translare de 25mm, acest câmp fiind inițial blocat, trebuie să se definească mai întâi un punct 

de referință, în acest caz s-a selectat colțul din drepta-jos (5). Iar ultimul pas este cel în care se indică 

direcția celor 3 copii create, perfect aliniate cu axa orizontală (7). 

 

Figura 2.21 

 Multiplicarea circulară se poate impune folosind comanda Rotate, , cu care se operează în 

mod asemănător. Diferenţe apar în ce priveşte elementul de referinţă care, de data aceasta este un 

punct selectat pe ecran iar pasul este unghiular, exprimat în [
0
]. Figura 2.22 conţine multiplicarea faţă 

de origine a cercului Ø 15, plasat iniţial pe verticală, cu un pas unghiular de 30
0
, numărul de elemente 

(Instances) fiind 3. 
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Figura 2.22 

Modificarea dimensiunilor unui element, în concordanţă cu o scară impusă este permisă prin utilizarea 

comenzii Scale, . După selectarea elementelor care trebuie scalate (de exemplu dreptunghiul 

100×70 mm din Figura 2.23 (1)), se activează comanda Scale care deschide caseta 

 

Figura 2.23 

de dialog Scale Definition, în care, se impune Duplicate Mode și Conservation of the Constraints, iar 

apoi, pe ecran se selectează punctul faţă de care are loc scalarea (în exemplu – originea (3)). Se 

completează valoarea scării de 0.5 și se obţine un nou dreptunghi, 50×35, vizibil în (6). De asemenea, 

vizibile sunt şi constrângerile menţinute (cotele din paranteze, orizontalitatea şi verticalitatea 

laturilor). 

 Operaţia Offset, , ca ultimă opţiune de transformare, permite realizarea multiplicării 

entităţilor, prin plasarea copiilor la o distanţă impusă faţă de obiectul-sursă. Se selectează elementul 

care urmează a fi supus operaţiei, apoi se impune Offset, din bară sau din Insert -> Operation -> 

Transformation. Din Sketch Tools, se impune numărul dorit de copii și modul în care să fie realizat 

noul contur, Figura 2.24 (3). Urmează să se execute un click în zona reprezentării, pentru a se 

specifica unde trebuie să fie plasate copiile, în interiorul sau exteriorul conturului selectat. Apar noile 

entităţi (5).  
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Figura 2.24 

 Figura 2.24 prezintă entitatea iniţială (dreptunghiul 100×70 mm), plasată într-o poziţie oarecare. 

După Offset No Propagation şi click pe ecran, precum şi după cotare, apare copia, un nou dreptunghi, 

plasat la 11,936 mm (pe ambele direcţii spre interior) faţă de dreptunghiul iniţial. Evident, distanţa de 

offset (cota 11,936) poate fi editată, prin operaţia obişnuită de editare a cotelor.  

 Bara Sketch Tools oferă patru opţiuni suplimentare: No Propagation, pentru a supune offset-ului 

doar elementul selectat; Tangent Propagation, prin care entităţile tangente elementului selectat sunt 

supuse offset-ului; Point Propagation, prin care se supun operaţiei elementele conectate prin puncte 

de capăt cu elementul selectat; Both Side Offset, prin care elementul selectat este copiat în ambele 

direcţii (de exemplu spre interior şi spre exterior), Figura 2.25. 

 

Figura 2.25 

 O categorie aparte de operaţii de editare-construcţie cuprinde proceduri care folosesc entităţi 3D 

deja realizate. Lanţul de comenzi este: Insert -> Operation -> 3D Geometry. Opţiunile posibile sunt: 

proiecţia pe planul de schiţare a elementelor 3D,  - se obţine curba de contur plană; intersecţia 

planului de lucru cu elemente 3D,  - se obţin contururi plane, care pot fi folosite în continuare; 

proiecţia pe plan a imaginii muchiilor spaţiale,  - se obţin linii în planul de schiţare; izolarea 

entităţilor, . Muchiile selectate de pe corpul din Figura 2.26 (1) au fost proiectate în planul schiței 

cu Project 3D elements, conturul obținut aparține schiței 2D și are culoarea specifică elementelor 

proiectate, culoarea galbenă. 
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Figura 2.26 

2.5.  Analiza schițelor plane 

 Funcţia Sketch Analysis este utilizată pentru a analiza diferite tipuri de erori din schiţă. Erorile 

pot include profile deschise, profile suprapuse, elemente izolate etc. De asemenea, această funţie 

poate determina şi starea constrângerilor din schiţa analizată, dacă schiţa este complet definită sau 

dacă este supra constrânsă. 

 Pentru activarea funcţiei Sketch Analysis se deschide meniul Tools din partea de sus a ecranului, 

Figura 2.27 (1). În fereastra Sketch Analysis, tab-ul Geometry este ales implicit şi conţine informaţii 

legate de starea geometriei din schiţă, acesta este împărţit în 3 zone. Prima zona, denumită General 

Status, ne indică analiza generală a întregii schiţe, cea de a doua zonă cuprinde o listă detaliată cu 

toate elementele geometrice care se regăsesc în schiţă (3), iar ultima zonă este cea în care regăsim o 

serie de butoane care ne ajută să edităm elementele selectate din listă, Corrective Actions (4). Din 

zona de editare se poate transforma un element standar în element de construcţie, un contur deschis se 

poate închide, un element se poate şterge, se pot ascunde toate constrângerile şi, respectiv, se pot 

ascunde toate elementele de construcţie.  

 
Figura 2.27 

 Dacă se alege tab-ul Use-edges, se obţin informaţii despre toate elementele din schiţă create prin 

proiecţie cu funcţia Project 3D Elements. 

 Dacă se alege tab-ul Diagnostic, se obţin informaţii despre starea constrângerilor dintre 

elementele pe care le conţine schiţa. 
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2.6.  Ieșirea din schiță 

După ce schiţa a fost realizată, ieşirea din modul Sketcher se realizează activând comanda Exit 

Workbench, , Figura 2.28 (1). 

 

Figura 2.28 

Astfel, schița se regăsește în modulul Part Design pregătită să fie utilizată de funcțiile care 

creează solide, iar ecranul revine la vizualizarea izometrică 3D. 

Dacă se dorește redeschiderea schiței create se dă dublu click pe numele schiței în arborele de 

specificații sau pe schiță în zona grafică de lucru. (ex. Sketch.1 din Figura 2.29)  

 

Figura 2.29 

Ecranul este implicit mov-închis, iar linia neconstrânsă apare albă; trecerea la ecran alb se face 

prin lanțul de comenzi: Tools -> Options -> Dispay -> Visualization -> Background, apoi se 

selectează culoarea dorită a fundalului. Pentru a fi vizibilă linia, trebuie urmat acest lanț de comenzi: 

Tools -> Options -> Mechanical Design -> Sketcher -> Default color of the elements, apoi se 

selectează culoarea dorită (negru, albastru etc.). Este recomandat să se evite alegerea culorilor care fac 

parte din categoria de diagnosticare a constrângerilor, cum ar fi roșu, vișiniu, violet etc. (aceste culori 

sunt vizibile în schiță dacă este bifată căsuța Visualization of dignosis). 

În Figura 2.30 sunt prezentați pașii necesari pentru realizarea unei schițe în modulul Sketcher. 
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Figura 2.30 

 

2.7.  Aplicaţii prezentate  

 În continuare sunt prezentate câteva exemple în care au fost utilizate comenzile şi paşii de 

proiectare prezentaţi în acest capitol, necesari pentru a obţine un model 3D. 

 Alături de imaginea de prezentare a exemplului propus este prezent un link şi o pictogramă cu un 

cod de acces QR (Quick Response), posibil a fi scanat cu un dispozitiv mobil. Link-ul şi codul deschid 

un tutorial video aflat pe platforma Google Drive. Totodată, fiecare piesă este prezentată printr-un 

desen de execuţie şi o vedere isometrică necesară unei mai bune înţelegeri a geometriei sale 

 
 

Exemplul 2.1 

 
Link-ul exemplului 2.1 
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Exemplul 2.2 

 

Link-ul exemplului 2.2 

Exemplul 2.3 

 

Link-ul exemplului 2.3 

https://drive.google.com/drive/u/0/folders/1gKDopr1wD_z0U6EgZJB41-inVjT3X1PY
https://drive.google.com/drive/u/0/folders/1Ke-coB9kFYjc9AG1zGBm3pXAdJzRiub5
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3. PROIECTAREA MODELELOR 3D ÎN CATIA V5 

 

3.1.  Elemente de bază utilizate pentru generarea solidelor (Basic features) 

Odată ce a fost stabilită schița de baza a solidului proiectat, trebuie să se stabilească care din 

elementele de bază se folosesc pentru a se finaliza modelul. Comenzile enumerate în lista de mai jos 

utilizează ca bază profile definite în schițe, Sketch-Based Features, așa cum este denumită și bara de 

lucru din care fac parte. 

 

Mai jos este o listă a elementelor de bază care adaugă material: 

A. Pad - materialul este adăugat prin extrudarea unui profil; 

C. Shaft - materialul este adăugat prin rotirea unui profil; 

F. Rib - materialul este adăugat folosind un profil care urmează o curbă; 

H. Stiffener - se adaugă nervuri; 

I. Multi-sections Solid - materialul este adăugat prin umplerea spațiului dintre profilele schițelor; 

Comenzile folosite pentru îndepărtarea materialului, sunt: 

B. Pocket - material îndepărtat prin extrudarea unui profil; 

D. Groove - material îndepărtat prin rotirea unui profil; 

E. Hole - comanda pentru realizarea alezajelor; 

G. Slot - materialul este îndepărtat folosind un profil care urmează o curbă; 

J. Removed Multi-section Solid - materialul este îndepărtat din spațiul dintre profilele utilizate; 

 Majoritatea comenzilor de pe bara Sketch Based Features au un meniu din care se selectează 

tipurile de limită, Figura 3.1, acestea pot fi:  

A. Dimension – acționează după o anumita valoare, Length; 

B. Up to Next – acționează până la următorul element, de exemplu: suprafața unui solid, permițând 

și un Offset; 

C. Up to Last – acționează până la ultimul element; 

D. Up to Plane – acționează până la planul selectat în câmpul Limit; 

E. Up to Surface – acționează până la suprafața selectată în câmpul Limit; 

A B C D E F G H I J
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Figura 3.1 

 

Funcția Pad  

Funcția Pad adaugă înălțime unui profil realizat cu ajutorul unei schițe sau suprafețe, pe o 

lungime definită valoric sau geometric. 

Pentru utilizarea acestei comenzi se selectează mai întâi profilul modelului din spațiul de lucru 

sau schița lui din arborele de specificații, Figura 3.2 (1), se deschide o fereastră cu o serie de câmpuri 

care pot fi 

 

Figura 3.2 

modificate (3), iar confirmarea se realizează prin apăsarea butonului OK (4).  

Solidul este realizat iar elementul Pad.1 este adăugat în arborele de specificații sub corpul 

PartBody, (5). 

Pentru un corp existent, prin dublu click pe elementul Pad.1 prezent în arbore de specificații sau 

pe volumul generat în spațiul de lucru, se pot edita și modifica setările funcției Pad.  

Mai jos, cât și în Figura 3.3, sunt prezentate toate setările care se pot face pentru funcția Pad. 

1. În câmpul First Limit se fac setările ce țin de tipul extrudării: Dimension, Up to Next etc. 

2. În câmpul Profile/Surface se selectează profilul schiței sau a suprafeței. 

3. Opțiunea Mirrored extent permite realizarea extrudării în ambele sensuri, simetric față de 

planul profilului. 

4. Butonul Reverse Direction permite schimbarea sensului în care se face extrudarea. 
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Figura 3.3 

Prin apăsarea butonului More fereastra inițială se extinde permițând o serie de noi setări. 

5. In câmpul Second Limit se pot face setări referitoare la a doua limită pentru adăugarea unei 

înălțimi. Cea de-a doua limită are aceeași direcție ca cea primară, dar în sens opus. 

6. Prin setările standard, adăugarea înălțimii unui profil se face pe direcție perpendiculară față de 

planul în care se găsește schița, deoarece este bifată opțiunea Normal to profile. Prin debifarea acestei 

opțiuni se pot realiza modele care să fie extrudate după o direcție impusă (dată de o dreaptă desenată 

într-o altă schiță, axa unui sistem de coordonare sau muchia unui solid). 

7.a. Bifarea opțiunii Thick permite realizarea solidelor extrudate cu o anumită grosime; devin 

active opțiunile din câmpul Thin Pad. Thickness1 permite stabilirea grosimii pe interior profilului, iar 

Thickness2 pe exteriorul profilului folosit. 

Activarea opțiunii Neutral Fiber face ca profilul să fie considerat o fibră neutră iar în acest caz 

grosimea este aplicată simetric față de el. 

Opțiunea Merge Ends prelungește capetele libere ale profilului până întâlnește un alt solid. 

 

Funcția Pocket 

Funcția Pocket este o funcție care are la bază un profil dintr-o schiță; prin această comandă se 

îndepărtează material din modelul proiectat. Toate opțiunile prezentate la comanda Pad se regăsesc și 

pentru comanda Pocket. 
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Figura 3.4 

Pentru a crea un element de tip Pocket se parcurg pașii prezentați în Figura 3.4. Se selectează 

profilul, se activează comanda Pocket, iar în fereastra care se deschide se completează câmpurile cu 

opțiuni, definindu-se așa cum se dorește această funcție, iar apoi confirmarea se realizează prin OK. În 

arborele de specificații se creează un nou element numit Poket.1, realizat cu profilul din schița 

Sketch.2. 

 

Funcția Shaft 

Comanda Shaft este utilizată pentru modelarea corpurilor de revoluție. Funcția Shaft construiește 

solide prin adăugare de material și prin rotirea unui profil sau suprafețe în jurul unei axe. 

Prin urmare, este necesară crearea unei axe în jurul căreia să se rotească profilul schiței; acesta 

poate fi închis sau deschis. Axa se construiește în schița profilului cu comanda Axis, . 

Se recomandă utilizarea procedeului prezentat în Figura 3.5, pentru cotarea diametrelor sau a 

razelor dintr-un profil față de o axă, în special pentru profilul care urmează să fie folosit în funcția 

Shaft. Se selectează linia de profil care urmează să fie cotată și apoi axa, iar înainte de a se așeza cota 

în spațiul de lucru se accesează meniul contextual, prin click dreapta, și se alege Radius/Diameter. 

 

Figura 3.5 
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Un corp de revoluție creat cu funcția Shaft se obține rotind în jurul unei axe, linii sau muchii ale 

profilului, de la 0
o
 la 360

o
 completându-se corespunzător spațiile din câmpul Limits: First angle 

(unghiul de rotație în jurul axei pornind de la poziția inițială a profilului în sens orar) și Second angle 

(unghiul de rotație în jurul axei pornind de la poziția inițială a profilului în sens trigonometric), Figura 

3.6. 

 

Figura 3.6 

 

Funcția Groove 

Funcția Groove este similară funcției Shaft doar că în loc să adauge material modelului, ea îl 

îndepărtează conform formei profilului utilizat. 

Dacă nu a fost realizată o axă în schița profilului, se poate selecta ca axă de revoluție, așa cum 

este prezentat în exemplul din Figura 3.7 (3), axa implicită a modelului solid existent. Sau se mai pot 

utiliza axele predefinite (X Axis, Y Axis și Z Axis) din meniul contextual prin click dreapta în spațiul 

Selection din câmpul Axis. 

 

Figura 3.7 

 

Funcția Hole 

Această funcție îndepărtează materialul dintr-un model sub formă circulară, creând un alezaj cu 

anumite dimensiuni. Pentru utilizarea comenzii Hole nu este necesar creerea unui profil într-o schiță, 

așa cum se procedează la comanda Pocket. În schimb, este necesar să existe un solid creat, adică 

suportul găurii, suportul este de preferat să fie o suprafață plană sau un plan. Parametrii alezajului se 

definesc în câmpurile ferestrei care se deschide la accesarea acestei comenzi. 

În fereastra de definire a comenzii Hole se găsesc 3 tab-uri, Figura 3.8, fiecare cu o serie de 

câmpuri pentru setările dimensionale ale alezajului: 

A. Extension;  

B. Type ; 

C. Thread Definition. 
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Figura 3.8 

1. Opțiuni referitoare la lungimea alezajului și diametrul acestuia; 

2. Opțiuni referitoare la direcția alezajului; 

3. Positioned Sketch deschide o schiță care permite poziționarea alezajului; 

4. Opțiuni care permit schimbarea geometriei la fundul găurii; 

5. Opțiuni referitoare la geometria și tipul alezajului; 

5.a alezaj de tip simplu cilindric, Simple; 

5.b alezaj de tip simplu conic, Tapered; 

5.c alezaj cu lamaj cilindric astfel încât capul șurubului să fie înecat, Counterbored; 

5.d alezaj cu lamaj conic astfel încât capul șurubului să fie înecat, Countersunk; 

5.e alezaj cu lamaj combinat: cilindric și conic, Counterdrilled; 

6. Parametrii care definesc fiecare tip de alezaj; 

7. Prin bifarea acestei opțiuni, Threaded, se activează opțiunile necesare definirii parametrilor 

filetului; 

8. Opțiuni care definesc limitarea lungimii filetului; 

9. Opțiuni care țin de tipul filetului și parametrii acestuia. 

Un alezaj poate fi creat folosind fie comanda Pocket fie comanda Hole. Avantajul folosirii 

comenzii Hole constă în faptul că nu mai este necesară realizarea unui profil într-o schiță (această 

schiță se creează automat) și se pot introduce informații tehnice care definesc alezajul (ca de exemplu 

parametrii unui filet, dimensiunile unui lamaj, unghiul de înclinare la fundul găurii etc.) 

Dacă se cunoaște, din etapele premergătoare proiectării unui model, că un profil care definește o 

gaură urmează să își modifice forma circulară, atunci se recomandă crearea acelei găuri cu funcția 

Pocket, în rest este de preferat folosirea comenzii Hole. 

 

Funcțiile Rib și Slot 

 Un alt procedeu de obținere a modelelor 3D este prin deplasarea contururilor după o curbă 

directoare. Procedura este similară cu cea de extrudare, dar folosește, în loc de direcția perpendiculară 

pe profilul schițat, o curbă directoare ce poate fi definită într-un plan. Profilul urmează curba. Funcția 
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Rib realizează un corp pozitiv, prin adăugare de material, iar funcția Slot realizează un corp negativ, 

prin îndepărtare de material Figura 3.9 (B). 

 În exemplul prezentat în Figura 3.10, după ce au fost realizate cele două schițe necesare, se 

activează funcția Rib (1). Profilul este sub formă de cer (2) și se completează în câmpul Profile, iar 

curba pe care o urmează și care este selectată în câmpul Center curve este arcul de cerc (3). Comanda 

Rib oferă posibilitatea de a controla direcția profilului prin 3 cazuri: Keep angle – unghiul dintre 

planul care conține profilul și tangenta la curbă rămâne constant; Pulling direction – profilul este 

extrudat de-a lungul curbei în raport cu o direcție specificată, aceasta poate fi un plan, o suprafață 

plană sau o muchie; Refrence surface – profilul este extrudat de-a lungul curbei respectând limitele 

unei anumite suprafețe de referință. Opțiunile Pulling direction și Reference surface au o opțiune 

suplimentară și anume Move profile to path. Această opțiune permite mutarea profilului pe curba 

directoare, în cazul în care acest lucru nu se întâmplă deja, și rotirea profilului în raport cu curba.  

 

Figura 3.9 

 Se pot obține modele cu o anumită grosime dacă se bifează căsuța Thick Profile, iar această 

grosime poate fi creată pe interiorul profilului, Thicness1 (5), pe exteriorul acestuia, Thicness2, sau și 

de o parte și de alta a profilului în mod simetric prin bifarea căsuței Neutral Fiber. 

 

Figura 3.10 

Funcția Stiffener 

 Funcția Stiffener utilizează procedeul de extrudare și îngroșare pornind de la un profil deschis. 

Nervurile pot fi creat în două moduri: din lateral - când schița este extrudată pe direcția planului 
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schiței și îngroșată pe direcția normală, Figura 3.11; și de sus - când schița este îngroșată pe direcția 

planului schiței și extrudată pe direcția normală, Figura 3.12.  

 

Figura 3.11 

  În Figura 3.11 se poate observa utilizarea unei schițe cu profil deschis, este o linie a căror capete 

sunt coincidente cu suprafețele solidului. Grosimea adăugată nervurii este de 6mm, Thickness1 (4), și 

este distribuită simetrică față de schița nervurii, câte 3 mm de fiecare parte a profilului, deoarece s-a 

bifat Neutral Fiber (5). 

 

Figura 3.12 

 Când este realizată o nervură, capetele liniei din profilul schiței sunt proiectate pe cea mai 

apropiată suprafață a solidului. Iar nervura ca să poată fi realizată trebuie să intersecteze complet 

fețele de sprijin. Dacă una din suprafețe dispare, din cauza modificărilor ulterioare, atunci funcția 

afişează un mesaj de eroare.  

Se recomandă pe cât posibil, modelarea nervurilor prin procedeul de extrudarea cu funcția Pad, 

deoarece aceasta utilizează profile închise care sunt mult mai stabile. 

 Pentru realizarea nervurii din Figura 3.12 a fost necesar crearea, mai întâi, a unui plan care se află 

la o anumită distanță față de suprafața plană din interiorul solidului, iar pe acest plan s-au realizat cele 

2 linii utilizate în funcția Stiffener (2), rezultând astfel o nervură care pornește de sus, From Top (3), 

spre interiorul modelului. 

 

Funcțiile Multi-sections Solid și Removed Multi-sections Solid 

 De obicei, se utilizează funcțiile Multi-sections Solid și Removed Multi-sections Solid pentru 

modelarea solidelor complexe și a geometrilor de tranzit dintre două solide existente. Prima funcție 

realizează un corp pozitiv, prin umplerea cu material a spațiului dintre secțiunile utilizate, iar funcția 

Removed Multi-sections Solid realizează un corp negativ, prin îndepărtarea de material dintre două sau 

mai multe secțiuni. 

 Pentru utilizarea corectă a acestor funcții trebuie ținut cont de următoarele 3 aspecte: 
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- Selectarea secțiunilor se realizează consecutiv în ordinea în care apar pe ecran și nu se ține cont 

de ordinea în care au fost realizate; 

- Punctele de închidere (Closing point) sunt afișate pentru fiecare secțiune selectată, aceste puncte 

de închidere indică modul în care sistemul conectează vârfurile profilelor, ele trebuie aliniate 

corect pentru a evita obținerea unor solide răsucite, Figura 3.13 (b) ; 

 

Figura 3.13 

- Săgeata care indică direcția de închidere a secțiunii trebuie să fie în aceeași direcție pentru fiecare 

secțiune, schimbarea direcției săgeții se obține apăsând pe ea cu cursorul. 

 În cazul în care punctele de închidere nu se regăsesc pe aceeași generatoare, nu sunt aliniate, se 

poate modifica poziția unui punct de închidere (Closing point) așa cum este prezentat în Figura 3.14. 

Se accesează meniul contextual prin click dreapta pe textul punctului respectiv și se alege comanda 

Replace (4), urmând să se aleagă apoi noul punct dorit (5). 

 

Figura 3.14 

 Fereastra Multi Section Solid Definition care se deschide la activarea acestei funcții se 

completează în partea superioară cu secțiunile care definesc corpul, Figura 3.15 (2), iar în partea 

inferioară în zona Guides se completeză cu schițele care conțin curbele de ghidare (3), rezultând un 

corp solid (6).  

 

Figura 3.15 
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 În cazul în care profilul nu are puncte corespondente în celălalt profil, se utilizează metoda de 

cuplare manuală a punctelor, metodă prezentată în Figura 3.16. După ce s-au ales secțiunile (2), se 

alege tab-ul Coupling și se introduc puncte cuplate (Coupling1, Coupling2 etc.) prin comanda Add 

pentru fiecare generatoare, selectându-se pe rând punctele care alcătuiesc generatoarea (6). Comanda 

Add devine activă doar dacă s-a selectat un câmp din fereastra Coupling (4), iar după selectarea 

consecutivă a tuturor punctelor care definesc o generatoare, se închide automat fereastra care s-a 

deschis la activarea lui Add. 

 

Figura 3.16 

 

3.2.  Comenzi de cosmetizare ale solidelor (Dress-Up Features) 

Odată ce a fost realizat solidul de bază, se poate trece la cosmetizarea lui cu ajutorul funcțiilor 

din bara de lucru Dress-Up Features. Această bară este prezentată mai jos, iar sub figură sunt enunțate 

principalele funcții de cosmetizare a modelului proiectat. 

 

A. Edge Fillet - funcție pentru racordarea muchiilor unui solid; 

B. Chamfer - funcție de teșire a muchiilor unui solid; 

C. Draft Angle - funcție pentru definirea unghiurilor de înclinare a suprafețelor; 

D. Shell - funcție pentru modelarea pieselor de tip „cochilie”; 

E. Thickness - funcție pentru adăugarea unei grosimi; 

F. Thread/Tap - funcție pentru adăugarea parametrilor care definesc un filet interior sau exterior; 

G. Remove Face - funcție pentru îndepărtarea unor porțiuni dintr-un solid. 

 

Funcția Edge Fillet  

Racordarea muchiilor unui solid se realizează cu ajutorul comenzii Edge Fillet. Această funcție 

permite rotunjirea muchiei de intersecție dintre două suprafețe, cunoscându-se valoarea razei.  

După ce se accesează comanda Edge Fillet, se completează valoarea razei, Figura 3.17. Dacă se 

selectează o suprafață, se racordează toate muchiile care mărginesc această suprafață (se recomandă 

evitarea acestui mod de selecție datorită controlului defectuos). De asemenea, se pot selecta individual 

toate muchiile care se doresc a fi racordate. 

Tipul de propagare a unei racordări se determină prin opțiunile Tangency (acest mod rotunjește 

muchia selectată și toate muchiile tangente la muchia selectată), Minimal (acest mod rotunjește doar 
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muchia selectată) sau Intersection (acest mod lucrează doar cu muchiile de intersecție cu alte 

elemente de bază, cum ar fi Pad, Pocket, Rib etc.). 

Se recomandă selectarea muchiilor pentru racordare sub aceeași comandă în funcție de rolul lor 

în definirea modelul, se grupează dacă muchiile au aceeași rază, dacă sunt prelucrate la fel sau dacă 

nu necesită schimbări majore pentru modificări ulterioare ale modelului. De exemplu, se pot grupa 

toate muchiile orizontale sau toate muchiile verticale care au aceeași valoare pentru rază. 

 

Figura 3.17 

 

 

Funcția Chamfer 

Cu ajutorul comenzii Chamfer se pot defini șanfrene pe muchiile unui solid. Teșirea unei muchii 

se poate realiza, fie prin selectarea muchiei respective, fie prin selectarea unei suprafețe, rezultând 

astfel teșirea tuturor muchiilor care o mărginesc, Figura 3.18. Funcția Chamfer permite două metode 

de definire a teșiturii:  

- cunoscând lungimea și unghiul adițional muchiei selectate, Lenght1/Angle; 

- cunoscând cele două lungimi adiționale muchiei selectate, Length1/Length2. 

 

Figura 3.18 

 

Funcția Draft 

 Funcția Draft permite înclinarea unor suprafețe sub un anumit unghi față de un element de 

referință denumit Neutral Element.  

Materialul este adăugat sau îndepărtat în funcție de valoarea și direcția unghiului. În exemplul din 

Figura 3.19, după ce au fost selectate suprafața care urmează a fi înclinată (4) și cea de referință (5), se 

decide dacă conul se creează spre exteriorul modelului sau spre interiorul său, modificarea direcției 

unghiului se realizează prin apăsarea pe săgeata portocalie de pe ecran (5), rezultând în final corpul 

dorit (7). 

 

Funcția Shell 

 Așa cum se poate observa și în Figura 3.20, funcția Shell îndepărtează una sau mai multe 

suprafețe din solid (2) și adaugă o grosime constantă tuturor suprafețelor rămase (3), de asemenea se 

pot adăuga grosimi diferite de material suprafețelor selectate în câmpul Other thickness faces. 
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Figura 3.19 

 Se recomandă să se evite proiectarea solidelor cu pereți de grosime diferită cu funcția Shell, 

deoarece dacă grosimile sunt aproximativ egale, vizual se vor distinge greu diferențele. 

 

Figura 3.20 

 Se recomandă să se ia în considerare ordinea elementelor care alcătuiesc un solid, atunci când se 

utilizează funcția Shell, deoarece aceasta extrage tot materialul solid dintr-un model, iar dacă nu se 

doreşte ca un element să fie înconjurat de material cu o anumită grosime, acest element ar trebui creat 

după utilizarea funcției Shell. De exemplu, atunci când modelul proiectat conține o gaură, aceasta are 

pereții îngroșați de funcția Shell, Figura 3.21 (a), dar dacă se dorește proiectarea modelului din figura 

(b), atunci gaura trebuie realizată după ce carcasa a fost golită de material. 

 

 

Figura 3.21 
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Funcția Thread/Tap 

 Termenul Thread este folosit pentru definirea filetului exterior, iar Tap este utilizat pentru filetul 

interior. În CATIA, geometria reală a filetului exterior sau interior nu este afișată, este reprezentată pe 

piesă cosmetic, dar elementele prezente în arborele de specificații conțin parametrii care definesc 

filetul și geometria filetului dorit, cum ar fi diametrul, pasul și adâncimea. CATIA are două standarde 

pentru filete, filete metrice cu pas normal (Metric Thick Pitch) și filete metrice cu pas fin (Metric Thin 

Pitch), dar pot fi adăugate și alte standarde utilizând butonul Add din fereastra Thread/Tap Definition. 

 

Figura 3.22 

 

 Pentru a crea un filet exterior pentru șurubul hexagonal prezentat în Figura 3.22, după activarea 

funcției Thread/Tap s-a selectat suprafață laterală a tijei șurubului cât și suprafața de început a 

filetului, Limit Face (3), s-a definit un filet metric M16 cu pas normal din standardul Metric Thick 

Pitck (4), iar lungimea tronsonului filetat este de 30mm, Thread Depth (5), cu filet pe dreapta (6). 

 Pentru a crea un filet interior, așa cum este prezentat în cazul piuliței hexagonale din Figura 3.23, 

se utilizează tot comanda Thread/Tap, dar după activarea acesteia se bifează Tap în fereastra 

Thread/Tap Definition care se deschide automat (2), apoi se selectează suprafețele care definesc 

filetul, suprafața laterală din gaura piuliței și suprafața limită de la care începe filetul, se definește 

filetul conform standardelor pe care le conține CATIA (4) și adâncimea zonei filetate. 

 
Figura 3.23 
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3.3.  Comenzi de editare ale solidelor (Transformation) 

Modelarea unui solid care conține părți identice poate duce la proiectarea îndelungată atunci când 

trebuie realizată fiecare parte individual, iar pentru a reduce timpul de proiectare se pot utiliza 

funcțiile de pe bara Transformation Features. Aceste funcții de modelare, fie au rolul de-a modifica 

poziția solidului față de sistemul de axe global (translarea, rotirea, simetria) sau de-a modifica solidul 

(micșorează/mărește corpurile prin scalare), fie multiplică anumite elemente ale solidului prin 

oglindire sau prin utilizarea unor șabloane (rectangular, circular, oarecare). 

 
 

A. Transformation 

a. Translation 

b. Rotation 

c. Symmetry 

d. AxisToAxis 

B. Mirror; 

C. Patterns; 

a. Rectangular Pattern 

b. Circular Pattern 

c. User Pattern 

D. Scale 

a. Scaling 

b. Affinity 

 

 

Funcțiile Translation și Rotation 

 Funcțiile Translation și Rotation permit translarea și rotirea unui solid în raport cu sistemul 

absolut de axe al fișierului CATPart. Pentru funcția Translation este necesară definirea unei direcții 

(poate fi o axă, o linie în spațiu sau o muchie) și a unei distanțe de translație, iar pentru funcția 

Rotation este necesară definirea unei axe de rotație și a unui unghi, Figura 3.24. 

 

Figura 3.24 

Funcțiile Symmetry și Mirror 

 Deplasarea și orientarea unui solid într-o nouă poziție se poate realiza cu funcția Symmetry, este 

necesar doar selectarea unui element de referință, care poate fi un plan, o suprafață sau o linie 

realizată într-o schiță, Figura 3.25 (a). În schimb, dacă se dorește deplasarea și orientarea copiei unui 

solid într-o nouă poziție, atunci trebuie utilizată funcția Mirror (b), de această dată este necesar să se 

selecteze atât solidul (Object to mirror), cât și elementul față de care se realizează oglindirea 

(Mirroring element). 
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Figura 3.25 

 

Funcția Rectangular Pattern 

 Utilizarea funcției Rectangular Pattern determină realizarea unor multiplicări a unor elemente 

după un șablon rectangular. În exemplul prezentat în Figura 3.26 se multiplică elemetul de tip gaură 

(Pocket.1), după ce acesta este selectat se activează funcția Rectangular Pattern, (2). Această funcție 

poate fi definită prin 4 moduri, în funcție de tipurile de parametri care sunt selectați din lista 

Parameters: Instance(s) & Length – când se cunosc numărul de copii și lungimea totală în care 

trebuie încadrate copiile echidistant; Instance(s) & Spacing – când se cunosc numărul de copii și 

distanța dintre ele; Spacing & Length – când se cunosc distanța dintre copii și lungimea totală; 

Instance(s) & Unequal Spacing – când se cunosc numărul de copii așezate la distanțe inegale. 

 Se selectează prima direcție după care urmează să fie realizat șablonul rectangular, în câmpul 

Reference element (4) poate fi selectată o muchie, o axă etc., iar apoi se completează câmpurile pentru 

cea de-a doua direcție de pe tab-ul Second Direction (5). 

 Când se creeză un tipar cu funcția Rectangular Pattern există opțiunea de a îndepărta manual 

copiile (Instance) care nu sunt necesare. Este suficient să se apese, pe rând, pe punctele portocalii din 

mijlocul copiilor, iar aceste se dezactivează, activarea lor se realizează prin aceeași metodă, se apasă 

din nou punctul portocaliu. 

 

Figura 3.26 

 

Funcția Circular Pattern 

 Utilizarea funcției Circular Pattern determină realizarea unor multiplicări a unor elemente după 

un șablon circular. În exemplul prezentat în Figura 3.27 se multiplică elemetul de tip gaură (Pocket.1), 

după ce acesta este selectat se activează funcția Circular Pattern, (2). Această funcție poate fi definită 
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prin 5 moduri, în funcție de tipurile de parametri care sunt selectați din lista Parameters: Instance(s) 

& total angale – când se cunosc numărul de copii și unghiul total; Instance(s) & angular spacing – 

când se cunosc numărul de copii și unghiul dintre ele; Angular spacing & total angale – când se 

cunosc unghiul dintre copii și unghiul totală; Complet crown – când numărul de copii sunt aşezate la 

unghiuri egale pentru un unghi total de 360deg; Instance(s) & unequal angular spacing - când 

numărul de copii sunt asezate la unghiuri inegale pentru un unghi total de 360deg. 

 Elementul de referință în jurul căruia se creează șablonul circular este axa Z, selectată din meniul 

contextual obținut prin click dreapta în câmpul Reference element (4). 

 Dacă se dorește obținerea unei multiplicări circulare sub formă de coroană în care elementele 

sunt așezate pe direcție circulară dar și pe direcție radială, se utilizează parametrii definiți în tab-ul 

Crown Definition (5).  

 

Figura 3.27 

 

Funcția User Pattern 

 Utilizarea funcției User Pattern determină realizarea unor multiplicări a unor elemente după un 

șablon oarecare, definit de proiectant. În exemplul prezentat în Figura 3.28 pentru a multiplica 

elemetul de tip gaură (Pocket.1), proiectantul definește poziția găurilor într-o schiță (Sketch.3). Schița 

conține 3 puncte, în punctele respective se află centrele cercurilor care definesc găurile. 

 

Figura 3.28 

 

Funcția Scaling 

 Rolul funcției Scaling este de a scala un element utilizând ca referință un punct, un plan sau o 

suprafață plană.  

 După activarea funcției, așa cum se observă în Figura 3.29 (1), se completează câmpul Reference 

în care se selectează punctul Point.1, creat anterior activării funcției, iar în câmpul Ratio se introduce 

valoarea (rația) de scalare. Astfel, corpul a fost scalat uniform pe toate cele 3 direcții deoarece punctul 

se afla în mijlocul corpului.  

 În acest exemplu valoarea de scalare fiind supraunitară (1,5), se generează un corp mărit 

corespunzător. Dacă valoarea este subunitară (spre exemplu 0,5) corpul rezultă micșorat 

corespunzător, respectiv cu 50%. 
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Figura 3.29 

 

3.4.  Aplicaţii prezentate 

 

Exemplul 3.1 

 
Link-ul exemplului 3.1 

 

 

 

Exemplul 3.2 

 
Link-ul exemplului 3.2 
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https://drive.google.com/drive/u/0/folders/1JHyR76BMU3zgUIbBs70Bg8vDR86e2HsS
https://drive.google.com/drive/u/0/folders/1zFoUjhaXhsLd2xwPnTmt2KbNkdAvX38_
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Exemplul 3.3 

 
Link-ul exemplului 3.3 

Exemplul 3.4 

 
Link-ul exemplului 3.4 

Exemplul 3.5 

 
Link-ul exemplului 3.5 

Exemplul 3.6 

 
Link-ul exemplului 3.6 

https://drive.google.com/drive/u/0/folders/1I7ttsGciXO3dp-4EaxlD1u1ZZD6pAbn1
https://drive.google.com/drive/u/0/folders/19ccSpjDgJju6Yu0cDfrt6FEnH2xjR6kZ
https://drive.google.com/drive/u/0/folders/1ryG44NBm9U7dndAZv-L_KQpAUuOxvEzS
https://drive.google.com/drive/u/0/folders/1A66H_6FGu32dyz9XDatJf0wgIvX_90NL
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Exemplul 3.7 

 
Link-ul exemplului 3.7 

Exemplul 3.8 

 
Link-ul exemplului 3.8 

Exemplul 3.9 

 
Link-ul exemplului 3.9 

 

 

 

 

 

 

 

 

https://drive.google.com/drive/u/0/folders/1Pvix1PTrB59dy5ZHF9vR5Eak7i_DbhPm
https://drive.google.com/drive/u/0/folders/1RxSd7B9X6JVEgwJ785aORjp_ncE_UO3P
https://drive.google.com/drive/u/0/folders/1zR6HfQf1d585FTJ8u6D6S2RISrNGmiQB
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Exemplul 3.10 

 
Link-ul exemplului 3.10 

 

https://drive.google.com/drive/u/0/folders/1JiMWbgez82KYnkIR3gTlVEpAzW9jmk_K
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4. PROIECTAREA MODELELOR COMPLEXE PRIN METODA MULTI-BODY 

 Pe măsură ce urmează să se proiecteze modele tot mai complexe, este important ca proiectantul 

să își dezvolte abilitatea de a structura etapele proiectării cât mai potrivit. Un model organizat cât mai 

potrivit are următoarele avantaje: 

- modelul este ușor de interpretat de către alți proiectanți; 

- modelul este predictibil, astfel încât se pot face ușor modificări sau actualizări; 

- modelul este ușor de rearanjat sau de înlocuit anumite elemente constructive; 

- anumite probleme ale modelului sunt ușor de rezolvat, deoarece cheia problemei este ușor de 

identificat. 

 În CATIA există o serie de unelte care permit proiectantului să își organizeze cât mai bine 

etapele de proiectare și anume: 

- corpurile (bodies, body) 

- datele geometrice (geometrical set) 

 Corpurile (bodies) sunt elemente de stocare și aranjare a funcțiilor care alcătuiesc un solid de tip 

Part. Un model complex poate fi alcătuit dintr-un număr nelimitat de corpuri. Fiecare corp se 

comportă independent față de celelalte până când acesta este integrat sau combinat cu celelalte corpuri 

cu ajutorul operațiilor booleene (boolean operations). 

 Datele geometrice (Geometrical Set) sunt de asemenea tot elemente de stocare și aranjare pentru 

funcțiile care definesc suprafețe și pentru elemente geometrice de referință (puncte, linii, plane, curbe 

în spațiu, schițe etc.). 

 În Figura 4.1 este prezentat un model care a fost creat utilizând metoda multi-Body, este vorba de 

o bielă a unui mecanism cu piston dintr-un motor al unui autovehicul. Fiecare corp a fost redenumit 

conform rolului pe care îl are în model, PICIORUL BIELEI, CORPUL BIELEI și CAPUL BIELEI. 

Corpurile mai pot fi redenumite în funcție de elementele din care sunt alcătuite acestea. 

 Modelul proiectat prin metoda multi-Body devine mult mai ușor de interpretat de către 

proiectant. De asemenea, proiectantul poate modifica funcțiile dintr-un anumit corp, reprezentând o 

zonă restrânsă a modelului, fără să influențeze structura totală a modelului. 

 

Figura 4.1 

CORPUL BIELEI

PICIORUL BIELEI

CAPUL BIELEI
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 Modul de lucru cu corpuri și operații booleene este particular doar pentru mediul de proiectare 

CATIA V5, nu se regăsește în alte programe de proiectare asistată de calculator (CAD). 

 Este recomandat ca piesele să fie construite în întregime cu ajutorul operațiilor booleene și nu ca 

o înșiruire de operații în cadrul unui singur corp. Cu cât complexitatea pieselor crește cu atât utilitatea 

funcțiilor booleene devine mai semnificativă. 

 Este recomandat ca în orice corp (body) să nu se utilizeze mai mult de cinci funcții de bază sau 

funcții booleene. 

 Este recomandat să nu se utilizeze în cadrul aceluiași corp atât funcții de bază cât și funcții 

booleene. 

 Este recomandat ca operațiile de cosmetizare (dress-up) să se facă după funcțiile de bază și după 

funcțiile booleene. Se pot utiliza oricâte operații de cosmetizare (dress-up) în cadrul aceluiași corp 

(body). 

 

4.1.  Elemente geometrice de referință 

 În modulul Part Design se pot crea puncte, linii și plane în afara mediului de lucru al schiței. 

Aceste elemente sunt denumite elemente geometrice de referință.  

 În funcție de cum s-au selectat opțiunile inițiale de creare ale unui Part, aceste elemente 

geometrice de referință pot fi afișate în arborele de specificații în două moduri.  

 Dacă s-a selectat opțiunea Enable hybrid design, elementele de referință vor fi afișate în arborele 

de specificații sub corpul PartBody, Figura 4.2 (1a).  

 Dacă opțiunea Enable hybrid design nu este selectată, elementele de referință sunt grupate ca 

date geometrice și se regăsesc în arborele de specificații sub fișierul Geometrical Set, Figura 4.2 (2a). 

Acest tip de fișier conține, doar elemente geometrice 3D, schițe și suprafețe, dar nu și elemente care 

creează părți solide. 

 

 

Figura 4.2 
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Crearea unui sistem de axe 

 După ce s-a deschis un Part nou, în mijlocul mediului de lucru 3D se pot observa cele 3 plane de 

bază de (xy plane, yz plane și zx plane); se recomandă să nu se utilizeze aceste plane în construcția 

modelelor, deoarece aceste plane de bază nu pot fi modificate, Figura 4.3 (1), ele doar se pot ascunde 

cu Hide/Show.  

 Se creează un nou sistem de coordonate cu ajutorul comenzii Axis System, , din bara Tools 

(2), iar planele de bază se ascund utilizând funcția Hide/Show (din meniul contextual afișat prin click 

dreapta pe fiecare plan în arborele de specificații), pentru a nu aglomera inutil spațiul de lucru (5). 

 

Figura 4.3 

 

Crearea punctelor și liniilor în spațiul 3D 

 Punctul este creat pentru a fi utilizat în marcarea unei locații a unui model sau pentru a fi folosit 

ca element ajutător în construcția altor funcții (comenzi), ca element de referință. 

 CATIA permite crearea unui punct prin mai multe metode, în funcție de tipul selectat din lista de 

opțiuni Point type din fereastra de definire a comenzii Point din bara Reference Elements, Figura 4.4 

(prin coordonate, coincident la o curbă, coincident la un plan etc.). 

 Linia dreaptă în spațiu poate fi construită folosind funcția Line, , din bara Reference 

Elements. Din fereastra care definește această comandă, Line Definition, se alege tipul de linie dintr-o 

listă de opțiuni Line Type: 

- Point-Point - definire prin punctele extreme; 

- Point-Direction - definire prin punct și direcție; 

- Angle/Normal to curve - normală la o curbă; 

- Tangent to curve - tangentă la o curbă; 

- Normal to surface - normală la o suprafață; 

- Bisecting - normală la o bisectoare. 

 În funcție de alegere, se specifică și caracteristicile elementelor care definesc linia, completându-

se pe rând toate câmpurile, fie prin selectarea elementelor create anterior sau accesând meniul 

contextual prin click dreapta în spațiul câmpului corespunzător. 

2

3

4

5

1



 

64 

 

Figura 4.4 

 

Crearea unor plane noi 

 Un plan se construiește prin comanda Plane, , tot din bara Reference Elements, Figura 4.5 

(1). În fereastra de definire a acestei funcții, Plane Definition, se poate opta pentru modul de definire a 

noului plan (2): 

- Offset from plane - paralel cu un plan de referință dar plasat la o anumită distanță de acesta; 

- Parallel through point - paralel cu planul de referință dar trecând printr-un punct impus; 

- Angle/Normal to plane - normal sau înclinat la un anumit unghi față de un plan; 

- Through three points - definit de trei puncte; 

- Through two lines - definit prin două linii; 

- Through point and line - definit print-un punct și o linie; 

- Through planar curve - definit prin curbe plane; 

- Normal to curve - normal la o curbă; 

- Tangent to surface - tangent la o suprafață; 

- Equation - definit printr-o ecuație; 

- Mean through points - definit prin puncte de mijloc. 

 În funcție de alegere, se specifică și caracteristicile elementelor care definesc planul, Figura 4.5. 

Se impune, de regulă, selectarea prealabilă a unui plan de referință, puncte, linii, curbe etc. 

 

Figura 4.5 
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 Se recomandă ca elementele de referință să fie grupate într-un Geometrical Set. De asemenea se 

recomandă, la realizarea elementelor de referință, să nu se folosească: suprafețele, muchiile sau 

elementele de cosmetizare ale unui solid. Motivul este că acestea pot suferi modificări ulterioare în 

proiectarea modelului (pot fi dezactivate, de exemplu o muchie racordată; își pot modifica forma, de 

exemplu o suprafață plană poate deveni o suprafață curbă etc.), iar elementele de referință sunt 

afectate și astfel modelul proiectat devine instabil. 

 

Geometrical Set 

 Datele geometrice de tipul Geometrical Set sunt asemănătoare cu folder-ele utilizate în Windows, 

ele permit stocarea informaţiei, stocarea unor elemente geometrice precum: linii, curbe, puncte, 

suprafețe, plane și schițe. 

 Elementele din interiorul unui set de date geometrice pot fi rearanjate mai sus sau mai jos în 

arborele de specificații fără să afecteze conceperea modelului. 

 Utilizarea multiplă a fișierelor Geometrical Set permite gruparea elementelor pe categorii. De 

exemplu, toate schițele se pot grupa sub un set de date geometrice redenumite SCHIȚE; elementele 

ajutătoare (liniile, punctele din spațiu și planele) pot fi grupate sub un set de date geometrice 

redenumit ELEMENTE DE REFERINȚĂ.  

 Fișierele Geometrical Set pot fi create și sub un corp (body), permițând gruparea elementelor de 

referință sau a schițelor utilizate la crearea acelui corp, astfel totul devine mai ușor de înțeles sau de 

modificat de către alți proiectanți. 

 Pentru a insera un nou set de date geometrice se parcurge traseul Insert -> Geometrical Set…. Se 

deschide o fereastră în care se poate completa denumirea noului set de date și se stabilește poziția în 

arborele de specificații, Figura 4.6. 

 

Figura 4.6 

 

4.2.  Metoda de proiectare cu mai multe corpuri, Multi-Body 

 Metoda de proiectare cu mai multe corpuri permite organizarea elementelor constructive ale unui 

model complex în corpuri diferite. Fiecare parte geometrică este realizată într-un corp separat, 

permițând astfel ca acesta să se comporte independent în model. Se recomandă gruparea elementelor 

constructive (features) care au design similar, sub același corp și denumirea lor să fie cât mai 

sugestivă pentru proiectant. 

 Există următorul dezavantaj: numărul de operații prin metoda cu mai multe corpuri, Multi-Body 

din Figura 4.7 (1a și 1b), este mult mai mare față de numărul de operații folosite la metoda de 

modelare standard, cea de înșiruire a operațiilor sub PartBody, (2). 
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Figura 4.7 

 Chiar dacă numărul de operații prin această metodă este mai mare, se recomandă utilizarea 

acestei metode de proiectare, deoarece are mult mai multe avantaje: 

- această metodă oferă o abordare organizată de proiectare a modelelor complexe;  

- elementele solide pot fi ascunse (hide/show) independent de restul modelului; 

- elementele constructive sunt grupate și pot fi activate sau dezactivate ușor de restul modelului; 

- o geometrie complexă este ușor de creat într-o zonă concentrată a modelului; 

- modelul se actualizează (update) mult mai repede pe o structură organizată; 

 

Realizarea corpurilor (bodies) 

 Un corp (body) este o zonă de stocare și aranjare a elementelor care alcătuiesc un solid de tip 

Part. Orice Part are un corp predefinit, el este denumit PartBody și se regăsește în arborele de 

specificații sub planele de bază.  

 Corpurile pot fi adăugate, pentru a crea o structură cât mai potrivită și ușor de înțeles a unui 

model complex, parcurgând traseul: Insert -> Body. 

 Corpul predefinit, PartBody, nu poate fi șters și asupra sa nu pot fi aplicate operații booleene. 

Din acest motiv se recomandă să se evite construirea solidului sub acest corp. 

 Cu toate că anumite module (workbench) necesită ca volumele realizate să se găsească în 

PartBody pentru a putea fi folosite, cum ar fi Generative Structural Analysis unde se realizează 

analize cu element finit, nu se pot atribui proprietățile de material dacă solidul nu se găsește sub 

corpul predefinit.  

 Pentru aceste cazuri excepționale se poate apela la modificarea unui corp adăugat (Body.2) într-

un corp predefinit (PartBody). Transformarea în Partbody se realizează prin click dreapta pe 

denumirea corpului din arborele de specificații (Body.2), iar din meniul contextual se alege Body.2 

object -> Change Part Body, Figura 4.8. 

 

Figura 4.8 
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Opțiunea Define in Work Object 

 Corpurile și datele geometrice seamănă cu folder-ele din Windows în care se pot stoca elementele 

geometrice, iar opțiunea Define in Work Object ajută la selectarea în care corp (body), sau în care date 

geometrice (geometrical set), să se stocheze aceste elemente geometrice. Folder-ul în care se lucrează 

este pus în evidență în arborele de specificații printr-o simbolizare grafică, numele acestuia fiind 

subliniat.  

 Tot cu opțiunea Define in Work Object se mai pot adăuga operații intermediare a modelului 

proiectat în arborele de specificații. Se selectează elementul sub care se dorește introducerea noului 

element, Figura 4.9 (1), iar prin click dreapta pe numele lui în arborele de specificații se alege din 

meniul contextual opțiunea Define in Work Object (2). A se observa că toate elementele de sub 

elementul subliniat (Pad.1) sunt dezactivate (3). După ce se adaugă noul element, pentru a activa toate 

elementele din arborele de specificații, trebuie setată comanda Define in Work Object pe Body.2. 

 

Figura 4.9 

 

 

Semnele corpurilor 

 Corpul predefinit PartBody nu are semn, deoarece nu poate fi utilizat în 

operații booleene. Toate celelalte corpuri pot fi create pentru adăugarea de 

material (ex. Pad, Shaft etc.), în acest caz corpul are semnul „+”, sau 

îndepărtarea de material (ex. Pocket, Groove etc.) și corpul are semnul „–”. 

 

4.3.  Operații Booleene 

 Solidele aflate în corpuri diferite nu formează un volum combinat, chiar 

dacă se intersectează între ele. Într-un anumit sens, este realizat un ansamblu 

între elementele rezultate din fiecare solid. Pentru combinarea acestora se utilizează funcțiile 

booleene.  

 Operațiile booleene se aplică între corpuri sau în același body. Ele permit combinarea, scăderea 

sau eliminarea solidelor. Accesarea operațiilor se poate face din bara Boolean Operations, din meniul 

principal Insert -> Boolean Operations, sau din meniul contextual afișat prin click dreapta pe 

denumirea corpului, se alege Body.2 object -> Add… (una din funcțiile booleene). Funcțiile booleene 

sunt: 

 

A. Assemble 

B. a. Add 
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b. Remove 

c. Intersect 

C. Union Trim 

D. Remove Lump 

 

Funcția booleană Assemble 

 Comanda booleană Assemble permite unirea a două solide aflate în corpuri diferite într-un singur 

volum.  

 Ca modalitate de lucru pentru a uni corpurile cu funcția Assemble, prima dată ar trebui create 

toate corpurile care se doresc a fi unite, apoi se creează un corp gol (ex. corpul Body.5 ASSEMBLE 

din Figura 4.10), în care sunt asamblate aceste corpuri.  

 

Figura 4.10 

 Se selectează comanda booleană Assemble, Figura 4.10 (1), din bara Boolean Operations, iar în 

fereastra de definire a acestei funcții se completează în ordine, corpurile care sunt unite între ele (2). 

 Funcția Assemble ține cont de semnul corpului astfel că, în cazul în care corpul are semnul „-” se 

realizează diferența dintre cele două corpuri. De exemplu, corpurile Body.3 și Body.4 din (5) sunt 

realizate având primul element Pocket, chiar dacă la prima vedere aceste corpuri par solide, folosite 

sub comanda Assemble aceste corpuri negative îndepărtează material din solidul inițial, rezultând o 

diferență dintre corpurile asamblate. 

 

Funcția booleană Add 

 Comanda booleană Add este similară cu funcția Assemble, adică permite unirea a două solide 

aflate în corpuri diferite într-un singur volum. Diferența dintre cele două funcții este aceea că funcția 

Add nu ține cont de semnul corpului adăugat; chiar dacă un corp este negativ, adică are ca prim 

element unul care îndepărtează material, (ex. Pocket, Groove etc.) când este unit cu un alt corp prin 

Add, acesta adaugă material, rezultând însumarea corpurilor, Figura 4.11. 

1

2

3

4

5



 

69 

 

 

Figura 4.11 

 

Funcția booleană Remove 

 Comanda booleană Remove permite „extragerea” unui solid dintr-un alt solid, indiferent de 

semnele pe care le au corpurile. 

 Se creează toate corpurile care se doresc a fi folosite sub funcția booleană Remove, apoi se 

creează un corp gol (Body.4 din Figura 4.12). 

 Acesta este folder-ul care conține primul corp, adăugat cu Assemble, și corpul care îndepărtează 

material, adăugat cu Remove. 

 

 

Figura 4.12 

 

Funcția booleană Intersect 

 Comanda booleană Intersect permite obținerea unui solid comun din două solide care se 

intersectează și se află în corpuri diferite. Dacă cele două corpuri nu se intersectează rezultă o eroare.  

 Pașii pentru utilizarea acestei comenzi sunt prezentați în Figura 4.13. 
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Figura 4.13 

Funcția booleană Union Trim 

 Funcția Union Trim permite obținerea unui solid comun din două volume și totodată, eliminarea 

unor elemente din geometria obținută.  

 După aplicarea funcției, există posibilitatea selecției unor suprafețe care elimină o porțiune din 

solidul total, Figura 4.14 (3a) și (3b). 

 

 

Figura 4.14 
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4.4.  Aplicaţii prezentate 

 

Exemplul 4.1 

 
Link-ul exemplului 4.1 

Exemplul 4.2 

 
Link-ul exemplului 4.2 

 

 

 

https://drive.google.com/drive/u/0/folders/1iQkva5VOGp6Grd6QltxB-IVuv0LK9Bv3
https://drive.google.com/drive/u/0/folders/1liSqu7vuLmHeFEAb5URHPPSE9lQo9Hdi
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5. ASAMBLAREA COMPONENTELOR ÎN CATIA V5 

 

 După deschiderea programului CATIA, apare pe ecran modul de lucru Product (specific 

asamblărilor 3D). Dacă se lucrează deja în program se poate deschide acest mod de lucru din START -

> Mechanical Design -> Assembly Design sau din File -> New, se deschide o fereastra denumită 

New, la fel ca cea din Figura 5.1, din care se selectează Product. 

 

Figura 5.1 

 În Figura 5.1 (3) se poate observa aspectul modulului Assembly Design în care se pot asambla 

două sau mai multe piese de tip Part, rezultând la final un fişier de tip Product .  

 

5.1.  Inserarea componentelor ansamblului 

 Funcţiile care ajută la inserarea sau creerea de noi piese în ansamblu sunt grupate pe bara de 

instrumente Product Structure Tools. 

 

A. Component - funcție pentru realizarea unei noi componente, aceasta poate fi doar o piesă sau un 

subansamblu de piese; 

B. Product - funcție pentru realizarea unui nou subansamblu; 

C. Part - funcție pentru realizarea unei noi piese; 

D. Existing Component - funcție pentru inserarea unei piese salvate anterior pe dispozitiv; 

E. Existing Component With Positioning - funcție pentru inserarea unei piese salvate anterior pe 

dispozitiv, cu specificarea poziţiei în spaţiul de lucru; 

F. Replace Component - funcție pentru înlocuirea unei componente; 

G. Graph tree Reordering - funcție pentru rearanjarea componentelor în arborele de specificaţii; 

H. Generate Numbering - funcţie pentru numerotarea componentelor; 

I. Selective Load - funcţie pentru încarcarea în spaţiul de lucru doar a câtorva subansambluri; 

J. Manage Representations 

K. Fast Multi Instantiation – funcţie pentru înserarea componentelor repetitive; 

 Odată deschis documentul de tip Product, urmează inserarea pieselor componente ale 

ansamblului. În acest scop, se activează butonul Existing Component, din bara Product Structure 

Tools. Această comandă trebuie urmată imediat (eventual imediat precedată) de selectarea, în arborele 

de specificaţii, a numelui fişierului, de exemplu Product 1, cum apare în Figura 5.2 (2). După această 
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dublă selectare apare caseta de dialog File Selection, în care prin rubrica Look in (3), se poate selecta 

din memoria calculatorului, numele documentului de tip Part care se doreşte inserat; Se selecteză 

Open (5), pentru a face posibilă apariţia modelului Part în spaţiul de reprezentare al ansamblului. 

Acelaşi efect poate fi obţinut şi folosind lanţul de comenzi Insert -> Existing Component -> Product 

1, selectarea modelului Part din caseta File Selection şi apoi Open. În arborele de specificaţii, sub 

Product 1 apare denumirea primei piese inserate în ansamblul, însoţit de numărul de ordine (6). 

Urmează insearea celorlalte piese, folosind exact acelaşi procedeu. 

 

Figura 5.2 

 Folosind comanda Existing Component, , pentru a introduce în mediul de asamblare piese 

exsistente, acestea sunt așezate una peste alta, deoarece toate piesele folosesc același mediu Part cu 

același sistem de coordonate. Comanda Existing Component With Positioning, , permite 

introducerea pieselor de tip Part deja existente dar și cu posibilitatea de a fi mutate într-o poziție 

dorită. După accesarea acestei comenzi trebuie selectat din arborele de comenzi Product 1 (la fel ca la 

comanda Existing Component). Odată cu apariția piesei se deschide o fereastră Smart Move, așa cum 

se poate observa în Figura 5.3, în această fereastră se poate muta piesa prin tragerea acesteia cu 

ajutorul cursorului. Efectul este vizibil instantaneu, iar după ce piesa a juns în poziția dorită se închide 

fereastra prin comanda OK. 

 

Figura 5.3  

 

Inserarea componentelor din catalog 

 CATIA are o bibliotecă de elemente de fixare standard şi piese comune. Acest catalog este o 

colecţie de componente în format read-only care pot fi utilizate într-un ansamblu. 

Pentru a insera o componentă din catalog se parcurg paşii prezentaţi şi în Figura 5.4:  

(1) se selectează comanda Catalog, iar apoi prin dublu click se selectează: 

(2) locaţia corectă a standardului din catalog, 

(3) categoria de componente dorită, 

(4) standardul corect din categoria de componente, 
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(5) componenta dorită, iar confirmarea se realizează apăsând pe OK în fereastra de previzualizare (6). 

 

Figura 5.4 

 

5.2.  Mutarea individuală a componentelor 

 De multe ori pentru a putea îmbina două piese este necesar ca ele să fie mutate sau rotite în 

spațiul de asamblare astfel încât să devină vizibilă muchia sau suprafața care trebuie constrânsă. 

CATIA permite manipularea individuală a pieselor fară să modifice poziția celorlalte componente ale 

ansamblului. Funcţiile care ajută la mutarea pieselor în spaţiul de lucru sunt grupate pe bara de 

instrumente Move. 

 

A. Manipulation - funcție pentru translarea sau rotirea pieselor în spaţiul de lucru; 

B. Snap - funcție de aşezare a unei piese peste sau lângă alta cu ajutorul unui element de 

referinţă; 

a. Snap 

b. Smart Move 

C. Explode - funcție pentru obţinerea unor vederi explodate; 

D. Stop manipulate on crash - funcție pentru translarea sau rotirea unui corp până la impactul cu 

un alt corp; 

 Prima funcţie de pe bara Move care poate fi folosită pentru translarea sau rotirea pieselor în 

spaţiul de lucru este funcţia Manipulation. După activarea acestei funcţii se deschide fereastra 

Manipulation Parameters, Figura 5.5. 
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Figura 5.5 

 Fereastra de manipulare conţine următoarele butoane:  

- translarea după axa x, y, z sau după orice altă direcție indicată; 

- deplasarea în planul xy, yz, xz sau oricare alt plan selectat;  

- rotirea în jurul axei x, y, z sau după orice axa sau muchie selectată.  

 Comenzile de translare după o direcție, deplasare într-un plan sau rotirea în jurul unei axe, devin 

active doar după selectarea butonului specific. (în Figura 5.5 (2) este activ butonul Drag along x axis, 

translare după axa x). Se modifică poziția piesei prin tragerea acesteia cu ajutorul cursorului (3). 

 Dacă este bifată căsuța With respect to constraints din fereastra Manipulation Parameter atunci 

componentele se pot muta în funcție de gradele de libertate pe care le mai au în urma constrângerilor 

dintre piese. 

 Snap este a doua comandă de pe bara Move, ea permite mutarea unei piese spre cealaltă 

componentă în funcție de elementul geometric (punct, axa, muchie, suprafața etc.) care a fost selectat. 

Elementul selectat prima dată se deplasează spre cel selectat a doua oară. De exemplu, dacă prima 

dată s-a selectat o muchie de pe o piesă, iar apoi   s-a selectat un punct de pe altă piesă, muchia se 

orientează astfel încât să treacă prin acel punct. 

 După ce s-a activat comanda Snap trebuie selectate elementele geometrice, în Figura 5.6 este 

prezentat un exemplu în care se selectează pe rând cele două muchii (2) şi respectiv (3), se observă 

lipirea celor două muchii selectate, iar dacă trebuie schimbată direcția piesei se apasă prin click pe 

săgeata verde (4). 

 

Figura 5.6 

 Sub comanda Snap prin derulare pe săgeata din dreapta-jos se găsește comanda Smart Move, 

Figura 5.7. Această funcţie este un instrument cu roluri multiple, în primul rând se pot manipula și 
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muta componente, dar în același timp se pot impune și constrângeri între piese, dacă este necesar. Prin 

apăsarea butonului More (2) fereastra se extinde și se poate observa o listă cu constrângeri (de 

contact, de coincidență, paralelism etc.).  

 

Figura 5.7 

 Se selectează pe rând de pe cele două piese elementele geometrice care pot fi: puncte, axe, 

muchii, plane, suprafețe plane sau circulare. 

 Constrângerile prezentate în listă sunt puse automat în funcție de elementele geometrice alese și 

de ordinea din listă. Prioritatea este de sus în jos, dar se poate modifica ordinea lor cu ajutorul celor 

două săgeți galbene din dreapta. 

 Bifarea căsuței Automatic constrain creation creează constrângeri permanente care apar și în 

arborele de specificații sub Constraints, dar dacă nu este bifată această căsuță piesele doar își mută 

poziția conform comenzii primite.  

 Dacă se selectează mai întâi componentele pe care vrem să le mutăm și apoi se accesează 

comanda Smart Move, se deschide o fereastră ca cea din Figura 5.8 în care se pot vizualiza pe rând 

piesele (butonul Next component permite trecerea de la o piesă la alta; acest buton nu este prezent în 

fereastră dacă a fost selectată doar o piesă). În acestă fereastră de vizualizare se poate roti sau mări 

piesa astfel încât să se poată selecta mai rapid și mai ușor elementul geometric folosit în această 

comandă. Se poate observa faptul că piesa mărită sau rotită în această fereastră de vizualizare nu și-a 

modificat aspectul sau poziția în spațiul de asamblare. Este foarte utilă acestă fereastră mai ales când 

ansamblul are multe componente iar unele muchii sau suprafețe nu sunt vizibile din cauza altor piese 

suprapuse. După ce au fost selectate elementele geometrice din fereastra de vizualizare, piesele își 

schimbă poziția în spațiul de asamblare și se poate confirma comanda cu OK. 

   

 

Figura 5.8 
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5.3.  Aplicarea constrângerilor de asamblare 

 După ce piesele au fost poziționate în spațiul de lucru acestea trebuie asamblate, acest lucru 

presupune constrângerea gradelor de libertate a fiecărei piese în parte. Dacă toate gradele de libertate 

a tuturor componentelor sunt restricționate atunci putem spune că ansamblul este constrâns complet. 

Dar sunt situații în care este necesar, mai ales dacă dorim să facem apoi o analiză dinamică, ca unele 

piese să mai aibă unele grade de libertate pentru a se putea mișca într-o anumită direcție, în acest caz 

spunem că ansamblul este parțial constrâns. 

 Comenzile de constrângere cer selectarea a două elemente geometrice de pe corpuri diferite, 

aceste elemente pot fi puncte, axe, muchii, plane, suprafețe etc. După ce cele două elemente au fost 

selectate apar o serie de simboluri specifice fiecărei constrângeri în parte ca de exemplu: , , 

 etc.  

 Aceste simboluri sunt unite printr-o linie, semn că respectiva constrângere a fost realizată, dar nu 

se vede efectul constrângerii până când nu se apăsă pe butonul Update All, , de pe bara Update. 

După apăsarea butonul de actualizare (Update All) piesa care nu este fixată în spațiul 3D se 

deplasează conform constrângerilor pe poziția corectă. 

 În continuare sunt prezentate mai detaliat comenzile de constrângere de pe bara Constraints. 

 

A. Coincidence Constraint - funcție pentru constrângerea de coincidenţă; 

B. Contact Constraint - funcție pentru constrangerea de contact dintre suprafeţe sau plane; 

C. Offset Constraint - funcție pentru definirea unei distanţe dintre două elemente; 

D. Angle Constraint - funcție pentru definirea unui unghi dintre două elemente; 

E. Fix Component - funcție pentru fixarea unui component; 

F. Fix Together - funcție pentru constrângerea unor componente să se deplaseze ca o entitate 

singulară; 

G. Quick Constraint - funcţie pentru crearea rapidă a constrângerilor în funcţie de o listă de 

priorităţi predefinită; 

H. Flexible/Rigid Sub-Assembly - funcție pentru modificarea stării subansamblului în flexibil sau 

rigid. 

I. Change Constraint - funcţie pentru înlocuirea unor tipuri de constrângere cu alt tip de 

constrângere; 

J. Reuse Pattern - funcţie care dublează o componentă reutilizând un model de tip Part. 

 

Fixarea componentelor 

 Prima dată ar trebui aleasă o piesă care să rămână fixă în spațiul 3D Product, urmând apoi să se 

constrângă celelalte piese în funcție de această piesă fixă. Pentru a fixa o piesă se utilizează comanda 

Fix Component, Figura 5.9 (1), de pe bara de lucru Constraints. După accesarea acestei comenzi se 

poate selecta piesa direct din spațiul de lucru sau din arborele de specificații (2). Odată selectată piesa, 

pe aceasta apare următorul simbol . Iar această constrangere se regăseşte sub denumirea Fix.1, în 

arborele de specificații sub Constraints, așa cum se poate observa în Figura 5.9 (3). 
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Figura 5.9  

Constrângerea de coincidență 

 Constrângerea de coincidență este folosită pentru a crea coincidența dintre axele a două elemente 

cilindrice, axele sunt selectate de pe componenete diferite. Această contrangere mai poate fi folosită și 

pentru a crea coincidența dintre puncte, muchii, plane sau suprafețe. 

 Se accesează comanda Coincidence Constraint iar pentru a selecta axele se apropie cursorul de 

primul element cilindric pănâ când această axa devine vizibilă, Figura 5.10 (2), se procedează la fel și 

pentru a doua axa (3). După ce au fost selectate axele, se observă simbolul specific acestei 

constrângeri , și totodată se vede o linie care unește cele două piese semn că s-a realizat 

constrângerea iar aceasta a fost adăugată și în arborele de specificații sub Constraints. Pentru a vedea 

piesa așezată pe poziția corectă conform constrângerii de coincidență se apasă pe butonul Update (4). 

 

Figura 5.10 

 

Constrângerea de contact 

 Constrângerea de contact este utilizată pentru a pune în contact două suprafețe plane sau 

cilindrice de pe componente diferite. Se pot selecta pentru această comandă următoarele elemente: 

plane, suprafețe plane, suprafețe cilindrice, sferice sau conice și muchii circulare.  

 Se selectează din bara comanda Contact Constraint urmând a fi alese cele două suprafețe care se 

doresc a fi în contact, de pe cele două componente diferite, Figura 5.11. 
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Figura 5.11 

 Dacă se aplică constrângerea de contact între două suprefețe cilindrice sau între o suprafață 

cilindrică și una plană, se deschide fereastra Constraint Properties, Figura 5.12 (1). Se alege 

orientarea contactului, dacă se realiză pe interiorul sau pe exteriorul cilindrului, din lista Orientation 

(2) și apoi se confirmă comanda cu OK (3). 

 

Figura 5.12 

 

Constrângerea de distanță liniară 

 Constrângerea de distanță liniară Offset Constraint este utilizată pentru a plasa elementele 

selectate la o anumită distanţă unele de altele. De asemenea, feţele sau planele selectate devin paralele 

între ele. Pentru a utiliza această constrângere se activează de pe bara de instrumente Constraints 

funcţia Offset Constraint. Se selectează primul element geometric, acesta poate fi: o faţă plană, o 

suprafaţă circulară, un plan, o axă sau un punct din zona geometriei. După selectarea celui de al doilea 

element, de pe cel de-al doilea component, se deschide fereastra Constraint Properties, Figura 5.13. 
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Figura 5.13 

 Dacă se selectează două suprafeţe plane, atunci sunt afişate două săgeţi care au rolul de a 

reprezenta orientarea planurilor unul faţă de celălalt. Planele pot fi orientate în aceeaşi direcţie (Same) 

sau în direcţii opuse (Opposite). Pentru a inversa sensul direcţie acestora, fie se apasă pe săgeţile din 

spaţiul grafic, fie se alege opţiunea dorită derulând meniul Orientation din fereastra Constraint 

Properties (2). 

 Valoarea distanţei dintre cele două componente se poate modifica ulterior direct din arborele de 

specificaţii, aşa cum se poate observa în Figura 5.14 este necesar să se selecteze prin dublu click 

constrângerea Offset şi să se completeze noua valoare în fereastra care se deschide (2). 

 

Figura 5.14 

 

Constrângerea de distanță unghiulară 

 Constrângerea de distanță unghiulară este utilizată pentru a poziționa două elemente geometrice 

la un anumit unghi unul față de celălalt. De asemenea, se poate utiliza această funcție pentru a așeza 

două suprafețe selectate paralele sau perpendiculare între ele.  
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Figura 5.15 

 Pentru a aplica această constrângere se alege comanda Angle Constrain de pe bara de instrumente 

Constraints. Se selectează primul element geometric, acesta poate fi: o faţă plană, o suprafaţă 

circulară, un plan, o axă sau o muchie. După selectarea celui de al doilea element, de pe cel de-al 

doilea component, se deschide fereastra Constraint Properties, Figura 5.15. 

 În fereastra Constraint Properties butonul radio Angle este selectat implicit (3), dar dacă este 

necesar, se poate opta pentru paralelism sau perpendicularitate (prin bifarea acestei opțiuni unghiul 

dintre suprafețele selectate este setat automat la 90
o
). 

 După ce contrângerea este aplicată, valoarea unghiului este afișată atașată la suprafețele selectate 

Figura 5.16 (1), iar în cazul în care a fost aplicată constrângerea de perpendicularitate sau paralelism, 

între fețele selectate apare simbolul perpendicular, respectiv simbolul paralel.  Numele 

constrângerii rezultate este, de asemenea, afișat în arborele de specificații (2). 

 

Figura 5.16 

 

Constrângerea Fix Together 

 Constrângera Fix Together este utilizată pentru a fixa poziția componentelor selectate una față de 

cealaltă. Odată ce componentele selectate sunt fixate împreună, ele pot fi mutate ca o singură 

componentă astfel încât poziția unei componente să rămână aceeași în raport cu o altă componentă.  

 Pentru a aplica această constrângere se alege comanda Fix Together din bara de instrumente 

Constraint și astfel se afișează fereastra Fix Together cum se poate observa în Figura 5.17 (1), pasul 

următor este selectarea componentelor care se doresc a fi legate (2), acestea vor apărea în fereastra Fix 

Together sub formă de listă în ordinea în care au fost selectate, pentru a șterge din listă un component 

selectat greșit este suficient să fie selectat din listă cu un singur click (3). Se confirmă constrângerea 

de legare prin utilizarea butonului OK (4). 
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Figura 5.17 

 

Utilizarea constrângerilor rapide de asamblare 

 În CATIA V5, există opțiunea Quick Constraint în care software-ul aplică constrângera cea mai 

adegvată pentru componetele selectate, utilizându-se de o listă cu constrângeri cu priorități diferite. 

Lista predefinită a constrângerilor are următoarea ordine: contact de suprafață (Surface Contact), 

coincidență (Coincidence), distanță liniară (Offset), distanță unghiulară (Angle), paralelism 

(Parallelism) și perpendicularitate (Perpendicularity). Se poate modifica ordinea acestor constrângeri 

și implicit prioritățile lor din opțiunile programului pe următorul traseu: Tools -> Options -> 

Mechanical Design -> Assembly Design pe tab-ul Constraints în zona Quick Constraint cu săgeţile 

laterale constrângerea selectată se mută în jos au în sus în funcţie de preferinţă. 

 

Schimbarea constrangerilor de asamblare 

 Cu ajutorul funcţiei Change Constraint se poate schimba o constrângere realizată între două 

componente cu o altă constrângere, acest lucru reprezintă înlocuirea tipului său (coincidenţă, 

paralelism, contact, distanţă liniară etc.) cu un alt tip de constrângere. Această operaţie depinde de 

elementele geometrice implicate în tipul de constrângere respectiv, dar şi de celelalte constrângeri 

existente între componentele ansamblului considerat. După activarea acestei funcţii şi selectarea 

constrângerei care se doreşte a fi modificată, Figura 5.18 (2) se deschide o fereastră cu o listă a 

constrângerilor care ar putea înlocui constrângerea selectată, Possible Constraints (3). Se selectează 

una din constrângerile din listă şi se confirmă prin apăsarea butonului OK (4).  

 

Figura 5.18 

 

Constrângerea Reuse Pattern 

 Uneori, in timpul asamblării componentelor, poate fi necesar să se asambleze o componentă de 

mai multe ori în funcţie de numărul de copii (instance) pe care le are un aranjament specificat. De 
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exemplu, în Figura 5.19 în cele 5 găuri pe care le are o placa trebuie asamblate un număr de 5 

şuruburi. După ce se extrage din catalog un şurub şi se constrânge într-o gaură, pentru celelalte 4 

şuruburi se poate utiliza funcţia Reuse Pattern, astfel se reduce numărul de operaţii necesare pentru 

asamblarea acestora şi de asemenea, se reduce timpul de proiectare a etape de asamblare. 

 Fereastra Instantiation on a pattern care se deschide imediat ce a fost activată comanda Reuse 

Pattern, are bifată căsuţa Keep Link with the pattern (2), ceea ce însemnă că rămâne activă legătura 

dintre exemplele noi create şi geometria modelului.  

 Se selectează din arborele de specificaţii componenta, în acest caz şurubul (3), iar apoi se 

selectează modelul care a dus la realizarea găurilor de pe placă, în acest caz CircPattern.1. Pot fi 

utilizate modele circulare (circular pattern), dreptunghiulare (rectangular pattern) sau unele 

predefinite printr-o schiţă (user pattern). 

 După setarea tuturor opţiunilor confirmarea comenzii se realizează apăsându-se pe OK (4), lista 

noilor componente este afişată în arborele de specificaţii şi tot aici a fost creat un nou nod, denumit 

Assembly features, iar sub acesta este afişat modelul circular utilizat şi componenta originală. 

 

Figura 5.19 

 

5.4.  Analiza ansamblului 

 Analiza ansamblului este necesară deoarece oferă proiectantului diferite informaţii privind starea 

constrângerilor, numărul gradelor de libertate pentru fiecare componentă, relaţiile de dependenţă între 

componente sau constrângeri, interferenţe între componente sau între ansambluri etc. Toate funcţiile 

de analiză ale ansamblului se găsesc în meniul Analyze. 

 Aşa cum se poate observa în Figura 5.20, pentru a analiza starea constrângerilor dintre 

componentele ansamblului suspensiei (2) şi gradele de libertate a fiecarei componentă în parte (3), s-a 

activat funcţia Constraints din meniul Analyze (1). Tab-ul Constraints din fereastra Constraints 

Analysis oferă informaţii legate de numărul total al componentelor care fac parte din ansamblu 

(Components), numărul componentelor care au rămas neconstrânse (Not constrained), numărul 

constrângerilor verificate (Verified), numărul constrângerilor imposibile de realizat deoarece 

geometria nu este comptibilă cu constrângerea folosită (Impossible), numărul constrângerilor care 

trebuie reactualizate (Not update), numărul constrângerilor din care lipseşte un element de referinţă 

(Broken), numărul constrângerilor dezactivate (Deactivated), numărul constrângerilor din modul de 

măsurare (Measure mode), numărul constrângerilor de fixare a componentelor (Fix Together) şi 

numărul total al constrângerilor utilizate în ansamblu (Total). 
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Figura 5.20 

 Funcţiile care ajută proiectantul să analizeze ansamblul din punct de vedere al interferenţelor 

dintre componete sau a distanţelor dintre acestea sunt grupate pe bara de instrumente Space Analysis. 

 

A. Clash - funcție pentru analiza interferenţelor dintre componente; 

B. Sectioning - funcție pentru vizualizarea ansamblurilor în secţiune; 

C. Distance and Band Analysis - funcție pentru analiza distanţelor dintre componente; 

 

Funcţia Clash 

  În cazul ansamblurilor complexe se recomandă să se verifice interferenţa şi jocul dintre 

componentele acestora. Identificarea şi eliminarea interferenţelor este absolut necesară, deoarece în 

majoritatea cazurilor ansamblul respectiv nu funcţionează. 

 Analiza interferenţelor de asamblare se realizează cu ajutorul funcţiei Clash de pe bara Space 

Analysis, Figura 5.21, sau se poate activa această funcţie din meniul Analyze -> Clash... Astfel se 

deschide fereastra Check Clash care are în zona Type (3) două meniuri pentru a selecta tipul de 

analiză dorit (analiză pentru contact şi interferenţă, Contact+Clash; analiză pentru joc, contact şi 

interferenţă, cu posibilitatea de a completa o valoare pentru joc, Clerance+Contact+Clash; analiza 

care permite penetrare pe o anumită distanţă, Autorized penetration etc.) şi opţiune pentru selectarea 

componentelor între care se calculează interferenţa. 

 După selectarea tututor opţiunilor pentru a se realiza analiza, se apasă butonul Apply (4), fereastra 

Check Clash se extinde şi se afişează rezultatul analizei. 

1
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4
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Figura 5.21 

 Zona de afişare a rezultatelor listează numele componentelor şi tipul de interferenţă 

corespunzătoare. Se afişează într-o fereastră de previzualizare (Preview) locaţia interferenţei dintre 

cele două componente selectate în lista analizei, Figura 5.22 (5), în această fereastră componentele se 

pot roti, mări sau micşora cu ajutorul funcţiilor pe care le deţine mouse-ul. 

 În fereastra de previzualizare se identifică prin cod de culoare zonele care interferează, acestea 

sunt prezentate prin culoarea roşie, iar în lista analizei valorile sunt negative (value); zonele care sunt 

în contact au culoarea galbenă sau portocalie şi valoarea zero în lista analizei; zonele între care există 

joc sunt prezentate cu culoarea verde, iar valorile sunt pozitive. 

 După verificarea interferenţelor necesare, se închide fereastra analizei apăsându-se pe butonul 

OK (7). 

 

Figura 5.22 
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Funcţia Sectioning 

 Uneori, este necesar ca un model de ansamblu să fie secţionat pentru a se vedea secţiunea 

transversală a acestuia, astfel se poate analiza poziţia componentelor în spaţiu şi se pot identifica 

interferenţele dintre piesele montate în interiorul ansamblului, care nu pot fi vizibile din exterior. 

 Pentru a secţiona un model de ansamblu, se alege funcţia Sectioning de pe bara Space Analysis, 

Figura 5.23, după activarea ei se deschide fereastra Sectioning Definition, în spaţiul de lucru se 

afişează planul de secţionare (3) şi fereastra Section.1, în care se observă reprezentarea 2D a vederii în 

secţiune (4). 

 În mod implicit, planul de secţionare coincide cu planul YZ, pentru a schimba poziţia planului de 

secţionare se plaşează cursorul peste acesta şi astfel se afişează o săgeată verde bidirecţională. Această 

săgeată este normală cu planul de secţionare, de asemenea, se poate utiliza busola roşie pentru a roti 

planul de secţionare. O altă metodă de a poziţiona planul de secţionare ar fi cu ajutorul butoanelor cu 

funcţii disponibile în tab-ul Positioning din ferestra Sectioning Definition. 

 

Figura 5.23 
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5.5.  Aplicaţii prezentate 

 

Exemplul 5.1 

 
Link-ul exemplului 5.1 

 

Exemplul 5.2 

 
Link-ul exemplului 5.2 

 

 

https://drive.google.com/drive/u/0/folders/1V2M1Kf_KwRl6VAlIeqyfEYxC7jdCPzaM
https://drive.google.com/drive/u/0/folders/1Hnz5Tp0FOZUpuiLdn0S8yxnyHtszfiI0
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6. MODULUL CATIA DRAFTING 

 Din punct de vedere al metodei de lucru, modulul CATIA Drafting poate fi considerat ca fiind 

construit din două submodule: Interactive Drafting și Generative Drafting. 

 Astfel, în Intereactive Drafting proiectantul creează vederile unei entități (piesă sau ansamblu) cu 

ajutorul instrumentelor de proiectare puse la dispoziție de program. Evident, din acest desen 

bidimensional nu se poate obține corpul tridimensional al respectivei entități proiectate. 

 În Genereative Drafting, pornind de la un corp tridimensional, creat anterior, se obțin numeroase 

proiecții (vederi și secțiuni) ale acestuia, reprezentând desenele de execuție necesare pentru o definire 

completă. 

 De asemenea, proiectantul trebuie să completeze proiecțiile obținute cu dimensiuni (liniare, 

unghiulare, de diametru etc.), cu condiții de rugozitate, de toleranță, cu adnotări, cu diferite rupturi, cu 

detalii etc. 

 În cazul ansamblurilor, modulul CATIA Drafting folosește numele componentelor acestora și 

ordinea în care au fost inserate pentru a crea în mod automat tabelul de componență. 

 

6.1.  Interfața modulului CATIA Drafting 

 Accesarea modulului CATIA Drafting din meniul START conduce la deschiderea implicită a 

unuia dintre cele două submodule, Interactive Drafting sau Generative Drafting, în funcție de 

existența în program a unui corp tridimensional, deschis sau creat anterior. 

 Astfel, dacă acest corp nu există, se deschide submodulul Interactiv Drafting. Desigur, în caz 

contrar, când în modulul CATIA Part Design se află un corp tridimensional, se deschide submodulul 

Generative Drafting. 

 Accesarea submodulului Generative Drafting se face din meniul START -> Mechanical Design -

> Drafting și se afișează fereastra de dialog New Drawing Creation, prezentată în Figura 6.1 (a). În 

aceasta proiectantul alege sistemul de proiecții pentru corpul tridimensional obținut, dar și standardul 

(spre exemplu, ISO), formatul paginii, orientarea și scara. 

 Apăsând butonul Modify… se deschide fereastra de dialog New Drawing, prezentată în Figura 6.1 

(b) pentru a selecta caracteristicile mediului de lucru. 

 

Figura 6.1 

 Pentru a modifica ulterior standardul, formatul, orientarea și scara planșei de lucru (Sheet) în care 

se realizează proiecțiile, se accesează fereastra cu proprietăți, din meniul contextual prin click dreapta 

pe Sheet.1 din arborele de specificații, Figura 6.2. 

a b
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Figura 6.2 

6.2.  Inserarea chenarului și a indicatorului 

 Crearea unui desen de execuție nu se rezumă numai la obținerea și cotarea proiecțiilor unei piese 

sau ansamblu, ci și la completarea acestora pe planșa de lucru cu chenar, indicator și tabel de 

componență. Planșa și proiecțiile se află în două zone distincte, la care proiectantul nu are acces 

simultan. Trecerea din zona proiecțiilor în zona planșei se face cu ajutorul opțiunii Edit -> Backgound, 

iar trecerea înapoi, din zona planșei în cea a proiecțiilor, cu opțiunea Edit ->Working View. 

 În zona planșei, din meniul Insert ->Drawing se alege opțiunea Frame and Title Block pentru a 

insera un chenar și un indicator, alese din cele câteva predefinite, puse la dispoziție de program, 

Figura 6.3. 

 Atât chenarul cât și indicatorul sunt create din linii, litere și cifre, proiectantul având posibilitatea 

să le modifice în conformitate cu standardul pe care îl utilizează. Toate câmpurile indicatorului sunt 

editabile, proiectantul având posibilitatea de a interveni pentru modificări și completări. Astfel, se pot 

adăuga datele legate de numele companiei, numele celuia care a creat și verificat desenul de execuție, 

numărul de revizuiri etc. În funcție de materialul din care se realizează piesa, programul afișează 

automat și greutatea acesteia, calculată anterior în modulul CATIA Part Design. 

 

Figura 6.3 

 Revenind în zona proiecțiilor, toate elementele chenarului și indicatorului se blochează, 

nemaifiind editabile, permițând proiectantului să se concentreze numai asupra proiecțiilor. 
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6.3.  Reprezentarea vederilor 

 Pentru reprezentarea obiectelor în desenul tehnic industrial sunt necesare, de multe ori, mai multe 

proiecţii care se amplasează în format într-o anumită ordine stabilită de standardul STAS 614-76. În 

această situaţie obiectul de reprezentat se consideră aşezat în interiorul unui cub, Figura 6.4, iar 

proiecţiile sale ortogonale se obţin pe feţele interioare ale cubului (metoda cubului de proiecţie), 

rezultând şase proiecţii. Desfăşurând feţele cubului într-un plan {1234} ca în Figura 6.4, se obţine 

desfăşurarea plană a proiecţiilor obiectului considerat, Figura 6.5. 

 

Figura 6.4 

 Dispunerea celor şase proiecţii rezultate se poate face ca în Figura 6.5 (a) sau ca în Figura 6.5 (b). 

 

Figura 6.5 

Bara de comenzi Views 

Bara de instrumente Views este activă numai în submodulul Generative Drafting, iar cu ajutorul 

acesteia, proiectantul obține diferite vederi, secțiuni și detalii referitoare la corpul tridimensional al 

piesei. 

 

 

 

 

 

 

 

a bMetoda E (utilizată în Europa) Metoda A (utilizată în America)

A B C D E F
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A. Projections 

a. Front View 

b. Unfolded View 

c. View From 3D 

d. Projections View 

e. Auxiliary View 

f. Isometric View 

g. Advanced Front View 

B. Sections 

a. Offset Section View 

b. Aligned Section View 

c. Offset Section Cut 

d. Aligned Section Cut 

C. Details 

a. Detail View 

b. Detail View Profile 

c. Quick Detail View 

d. Quick Detail View Profile 

D. Clippings 

a. Clipping View 

b. Clipping View Profile 

c. Quick Clipping View 

d. Quick Clipping View Profile 

E. Break view 

a. Broken View 

b. Breakout View 

c. Add 3D Clipping 

 

 

Inserarea vederii principale (Front View) 

 Din bara Views se apelează comanda Front View, , după care se comută în fișierul 

modelului 3D selectându-se fața ce se dorește a fi vedere principală, Figura 6.6 (1). În paralel, în 

colțul dreapta-jos al modelului 3D, apare o previzualizare a vederii principale, (2). Click pe fața dorită 

ca și vedere principală și se revine automat în modulul CATIA Drafting unde, de asemeni, programul 

face o previzualizare a vederii principale (3). 
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Figura 6.6 

 Observație: înainte de a stabili definitiv vederea principală, există posibilitatea ca 

previzualizarea (3), să fie rotită atât în planul foii cât și în celelalte două plane (perpendiculare pe 

cel al reprezentării), utilizând butonul din (4). Când vederea principală are reprezentarea convenabilă, 

se face click pe spațiul foii sau în zona centrală a „telecomenzii” din (4). Dacă poziția vederii nu este 

convenabilă, aceasta poate fi mutată, prin manevra drag and drop (click pe vedere, glisare mouse, 

eliberare buton mouse), în altă locație din spațiul foii. Ar trebui să se obțină ceva asemănător cu (5). 

Inserarea vederii laterale (Projection View) 

 Urmează definirea unei proiecții ortogonale care se face cu ajutorul comenzii Projection View, 

din bara Views, Figura 6.7 (1). Odată lansată, în funcție de poziționarea mouse-ului pe foaie, mediul 

CATIA ne face „propuneri” în vederea stabilirii noii vederi, aici fiind hotărâtoare experiența 

inginerească. Click în zona corespunzătoare vederii și, deja, prima proiecție ortogonală este realizată 

(Top View, (2)). 

 
Figura 6.7 

 Fiecare vedere este încadrată de un chenar ce poate avea două culori: roșu, când vederea este 

activată și albastru, când vederea este dezactivată. Pentru o bună aranjare a vederilor pe planșa de 

lucru a desenului de execuție, acestea se pot deplasa stânga-dreapta sau sus-jos, în funcție de tipul 

vederii. 

 În mod implicit, toate proiecțiile create în modulul CATIA Drafting sunt la scara 1:1 și poartă un 

nume prestabilit, precum: Left View, Front View, Top View, Isometric View etc.  Aceste proprietăți, 
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dar și altele, precum orientarea vederii, prezența liniilor de simetrie, a filetelor, a liniilor ascunse 

(hidden lines) etc., pot fi modificare utilizând fereastra de dialog Properties accesibilă din meniul 

contextual (vizibil prin click dreapta) al vederii respective, Figura 6.8. 

 

Figura 6.8 

Inserarea vederii izometrice (Isometric View) 

 În vederea izometrică se reprezintă un corp 3D în concordanță cu un anumit plan de proiecție. 

Planul respectiv permite, astfel, o vizualizare în perspectivă. 

 Pentru a obține o vedere izometrică este necesară plasarea obiectului astfel încât muchiile sale să 

facă unghiuri egale cu planul de proiecție. 

 Se apasă pictograma Isometric View și se selectează un plan de referință pe corpul 3D deschis în 

modulul CATIA Part Design. Astfel, pentru semicupla Oldham, a fost selectat ca plan de referință fața 

frontală pe care se regăsesc cele două caneluri de cuplare. Pentru o mai facilă selectare a corpului 3D 

se recomandă așezarea în paralel, alăturat, pe verticală, a ferestrelor ce conțin modulul Part Design, 

respectiv modulul Drafting, cu ajutorul opțiunii Tile Vertically din meniul Window, Figura 6.9. 

 

Figura 6.9 

 

Reprezentarea secțiunilor 

 Secţiunea este reprezentarea, în proiecţie ortogonală pe un plan, a unui obiect după intersectarea 

acestuia cu o suprafaţă fictivă de secţionare şi îndepărtarea imaginară a părţii obiectului aflată între 

ochiul observatorului şi suprafaţa respectivă. 

 După modul de reprezentare secțiunea se clasifică: 
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 a. secţiune cu vedere, când se reprezintă în vedere, odată cu secţiunea propriu-zisă respectivă, şi 

partea din obiect vizibilă în spatele suprafeţei de secţionare (Figura 6.10 (A), în CATIA se obține 

acest tip de secțiune utilizând comanda Offset Section View, ); 

 b. secţiune propriu-zisă, când se reprezintă numai figura care se obţine din intersectarea 

obiectului cu suprafaţa de secţionare (Figura 6.10 (B), în CATIA se obține acest tip de secțiune 

utilizând comanda Offset Section Cut, );  

 

Figura 6.10 

Inserarea secțiunii plane cu vedere (Offset Section View) 

Din bara Views se utilizează comanda Offset Section View, , 

 

Figura 6.11 

printr-o succesiune de click-uri în vederea principală se trasează axa verticală de secționare, iar apoi 

se confirmă această acțiune printr-un dublu click în spațiul de lucru și se poziționează secțiunea în 

dreapta vederii principale, Figura 6.11.  

 Hașurarea secțiunii este făcută automat de către program, dar, în unele cazuri, este necesar ca 

proiectantul să intervină pentru a modifica unghiul hașurii, pasul acesteia, tipul și grosimea liniei cu 

care a fost trasată etc. această editare se realizează din meniul contextual apărut în urma executării 

unui click dreapta pe hașură și alegerea opțiunii Properties, Figura 6.12. 

 

Figura 6.12 
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Este posibil ca, în cazul hașurilor decalate, aflate de o parte și de alta a 

unui plan, să se șteargă o porțiune de hașură și să se creeze alta cu ajutorul 

comenzii Area Fill Creation,  situată în bara de instrumente Dress-Up. 

Acest instrument hașurează o zonă închisă, hașura are, de regulă, aceleași 

caracteristici cu cea care a fost anterior înlăturată. Pentru a fi decalată față de 

cea aflată de cealaltă parte a planului de secționare, trebuie modificat parametrul Offset, la o valoare 

recomandată de jumătate din cea stocată în parametrul Pitch (pasul hașurii). Orice actualizare a 

secțiunii respective retrasează și porțiunea de hașură înlăturată, de aceea se recomandă izolarea 

secțiunii accesând opțiunea Isolate din meniul contextual. 

 

Inserarea secțiunii propriu-zisă deplasată (Offset Section Cut) 

 Se creează secțiunea propriu zisă cu ajutorul comenzii Offset Section cut, aceasta poate fi 

deplasată numai pe orizontală atâta timp cât nu se utilizează opțiunea Position Independently of 

Reference View, accesibilă din meniul contextual View Positioning, meniul devine accesibil prin click 

dreapta pe vederea nou creată. Deplasarea vederii se face cu ajutorul mouse-ului, Figura 6.13. 

 

 

Figura 6.13 

 

Reprezentarea rupturilor 

 Ruptura este reprezentarea convențională, în proiecție ortogonală pe un plan, a unei piese din 

care se îndepărtează o anumită parte, separând-o de restul piesei printr-o suprafață de ruptură, ea se 

execută cu scopul: 

a. Reducerii spațiului ocupat pe desen de reprezentarea piesei, prin îndepărtarea părții rupte, în 

special la piesele lungi, fără ca să fie afectată claritatea și precizia reprezentării; 

b. Reprezentării unor părți ale piesei, care la reprezentarea în vedere sunt acoperite de partea 

îndepărtată; 

Inserarea unei rupturi pentru reducerea spațiului (Broken View) 

 Pentru a insera o ruptură pentru reducerea spațiului se utilizează comanda Broken View. După ce 

a fost activată această comandă, Figura 6.14 (1), se stabilește lungimea rupturii print-o serie de 3 

click-uri. Primul este utilizat pentru a marca începutul rupturii (2), al doilea click confirmă direcția (pe 

verticală sau orizontală) și înălțimea rupturii (3), iar ultimul click stabilește lungimea rupturii (4). 
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 Rupturile realizate cu funcția Broken View se realizează la sfârșit, deoarece se poate observa că 

după utilizarea ei o serie de comenzi sunt blocate (6), cum ar fi comenzile pentru secțiuni, pentru 

detalii sau pentru alte tipuri de rupturi. 

 

Figura 6.14 

Inserarea unei rupturi pentru vederea unei părți din piesă (Breakout View) 

 Se activează comanda Breakout View (1), urmând să se definească forma aproximativă a rupturii 

printr-un contur închis (2), iar după ce se obține conturul închis apare fereastra 3D Viewer unde este 

previzualizat planul în care se realizează ruptura (3), prin confirmarea cu OK se obține vederea cu 

ruptura aferentă (5), Figura 6.15. 

 

Figura 6.15 

Reprezentarea detaliilor 

 În unele cazuri, proiectantul indică în desenul de execuție unul sau mai multe detalii care 

reprezintă un anumit element al piesei, aflat într-o vedere sau în secțiune. Pentru obținerea acestor 

detalii se utilizează instrumentele Details (Detail View, Detail View Profile, Quick Detail View și 

Quick Detail View Profile). 

 Un detaliu corespunde unei anumite zone a desenului de execuție, mărită la o scară diferită de 

1:1. În mod uzual se adoptă scări 2:1, 3:1, 4:1, 5:1 etc. detaliul ce surprinde zona respectivă poate 

avea formă circulară sau una oarecare, poligonală, trasată de proiectant. Evident, într-un detaliu cotele 

sunt scrise la valoarea reală, nefiind modificare după factorul de mărire. 
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Inserarea unui detaliu (Detail View) 

 Un detaliu obținut cu funcția Detail View este prezentat în Figura 6.16. Se stabilește zona pe care 

se dorește a fi mărită cu ajutorul unui contur sub formă de cerc, a cărui rază poate fi modificată (2), 

scara detaliului obținut se modifică utilizând opțiunea Properties din meniul contextual al acestei 

vederi. 

 

Figura 6.16 

 In cazul desenelor realizate pe calculator liniile de ruptură pot fi trasate în diferite moduri în 

funcție de programul ales. În programul CATIA aspectul lor se modifică cu ajutorul comenzilor de pe 

bara de instrumente Grafhic Properties. 

 

 Bara de instrumente Graphic Properties permite stabilirea culorii, tipului și grosimii unor linii 

din desen, copierea acestor caracteristici, apoi aplicarea lor pentru alte linii (Copy Object Format, 

) și stabilirea tipului de hașură (Pattern) în funcție de materialul ales de proiectant pentru piesa al 

cărei desen de execuție este în lucru. 

 

6.4.  Cotarea în desenul tehnic 

 După ce au fost create vederile, secțiunile, rupturile și detaliile, în continuare, proiectantul poate 

opta pentru cotarea manuală sau automată a desenului de execuție. Pentru cotarea manuală se 

utilizează instrumentele din bara Dimensioning, iar pentru cotarea automată cele din bara Dimension 

Generation. 
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A. Dimensions 

a. Dimensions 

b. Chained Dimensions 

c. Cumulated Dimensions 

d. Stacked Dimensions 

e. Length/Distance Dimensions 

f. Angle Dimensions 

g. Radius Dimensions 

h. Diameter Dimensions 

i. Chamfer Dimensions 

j. Thread Dimensions 

k. Coordinate Dimensions 

l. Hole Dimension Table 

m. Coordinate Dimension Table 

 

 Prima funcţie de pe bara Dimension este funcţia cu acelaşi nume, Dimension. Această funcţie 

poate dimensiona cote de lungime, cote de rază sau cote de diametru, în funcţie de elementul selectat 

spre cotare. Împreună cu setările suplimentare pe care le conţine bara Tools Palette, se pot obţine cote 

orientate pe orizontală, pe verticală, pe diagonală sau cote ancorate de anumite punte de intersecţie a 

elementelor care formează conturul piesei. 

 

Inserarea unei cote de lungime (Length/Distance Dimensions) 

 Inserarea unei cote de lungime necesită folosirea comenzii Length/Distance Dimensions, modul 

de utilizare al acestei comenzi este prezentat în Figura 6.17, prin care se selectează o singură muchie 

de pe piesă sau în Figura 6.18 prin care se obține cota după ce au fost selectate două muchii de pe 

piesă. 

 

Figura 6.17 
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Figura 6.18 

 Când sunt selectate două elemente diferite, așa cum este prezentat în exemplul din Figura 6.19 un 

element de arc și un segment de dreaptă, există posibilitatea de a modifica punctele de ancorare ale 

cotei respective cu ajutorul opțiunii Extension Lines Anchor, din meniul contextual accesat prin click 

dreapta înainte de a așeza cota în spațiul de lucru. 

 

Figura 6.19 

 

Comanda Chained Dimensions 

 Utilizarea comenzii Chained Dimensions care permite cotarea în linie (lanț) este prezentată în 

Figura 6.20. După ce a fost activată această comandă (1), din bara Tools Palette se merge pe opțiunea 

Force Horizontal dimension in view (2), urmând să fie selectate una după alta toate elementele care se 

cotează (3-6), iar la sfârșit se așează cota de tip lanț în spațiul de lucru (7). 

 

Figura 6.20 
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Comanda Cumulated Dimensions 

 Se alege comanda Cumulated Dimensions (1), urmând să fie selectat prima dată elementul comun 

față de care se raportează celelalte cote (3), iar apoi toate celelalte elemente care au mai rămas (4-6). 

La sfârșit se așează aceste cote în spațiul de lucru (7), Figura 6.21. 

 

Figura 6.21 

 

 

Comanda Staked Dimensions 

 În Figura 6.22 este prezentată utilizarea comenzii Staked Dimensions (1). La fel ca și în cazul 

comenzii Cumulated Dimensions, prezentată anterior, prima dată se selectează elementul comun față 

de care se raportează celelalte cote (3), urmând apoi să fie selectate toate celelalte elemente (4-6), iar 

la sfârșit se așează aceste cote în spațiul de lucru (7). 

 

Figura 6.22 

Inserarea unei cote de unghi (Angle Dimensions) 

 Inserarea unei cote de unghi se realizează cu ajutorul comenzii Angle Dimensions, utilizarea 

acestei comenzi este prezentată în Figura 6.23. Înainte de a poziționa cota în spațiul de lucru se poate 

decide din ce cadran să facă parte acel unghi, folosind opțiunea Angle Sector din meniul contextual 

accesat prin click dreapta. 
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Figura 6.23 

Inserarea unei cote de raza (Radius Dimensions) 

 Inserarea unei cote care definește o rază sau o racordare se realizează cu ajutorul comenzii 

Radius Dimensions, modul de utilizare al acestei comenzi este prezentat în Figura 6.24. În cazul 

racordărilor, după ce se activează comanda Radius Dimensions se selectează arcul de cerc dintre 

suprafețele racordate și se poziționează în spațiul de lucru cota respectivă. 

 

Figura 6.24 

Inserarea unei cote de diametru (Diameter Dimensions) 

 Pentru inserarea unei cote care definește un cilindru de un anumit diametru se utilizează comanda 

Diameter Dimensions, aceasta este prezentată în Figura 6.25. 

 

Figura 6.25 

Click-dreapta

1

2

3

4

5

6

7

1
2

3
4

a b

1

2

3
1

2

3
4



 

102 

Cotarea unei teșituri (Chamfer Dimensions) 

 Teșiturile se cotează folosind comanda Chamfer Dimensions, se selectează efectiv linia de trecere 

intre două suprafețe concurente. Orientarea cotei se poate face orizontal, înclinat sau vertical, în 

funcție de poziția teșiturii pe desen. Stabilirea acestei orientări se realizează din meniul contextual al 

cotei respective, opțiunea Properties în tab-ul Dimension line, Figura 6.26. 

 

Figura 6.26 

Comanda Thread Dimension 

 În Figura 6.27 sunt prezentate 3 exemple de cotarea a unor găuri filetate. 

 

Figura 6.27 

 
 Se selectează comanda Thread Dimension (1), urmată de selecția orientării cotei din bara Tools 

Palette (2), iar la final se selectează liniile care simbolizează filetul din vederea frontală sau din cea 

secționată (3). 

 În modulul CATIA Drafting o gaură filetată este reprezentată în desenul de execuție conform 

standardului SR ISO 6410-1:1995, în care sunt prezentare modul de reprezentare a filetelor pe desenul 

tehnic, doar dacă alezajul a fost realizat în modulul CATIA Part Design cu funcția Hole, , iar în 

tab-ul Thread Definition a fost bifat opțiunea Threaded (completându-se astfel parametrii filetului) 

sau dacă filetul a fost adăugat ulterior prin comanda Thread/Tap, , Figura 6.28. 
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Figura 6.28 

 În cazul în care, de pe proiecția obținută lipsesc simbolurile specifice reprezentării filetelor, 

acestea se pot adăuga prin bifarea opțiunii Thread din câmpul Dress-up al tab-ului View din fereastra 

de dialog Properties, accesând meniul contextual al portului de vedere, Figura 6.29. 

 

Comanda Hole Dimension Table 

 În Figura 6.30 este prezentată metoda de cotare în coordonate, prima dată se selectează toate 

găurile ce trebuie cotate (1-3) și apoi se activează comanda Hole Dimension Table (4), din fereastra 

care se  

 

Figura 6.29 

deschide se pot rearanja coordonatele sistemului de axe pe direcția x și pe direcția y (5). Se poate 

stabili un titlu pentru tabelul ce urmează a fi creat și modul de afișare al liniilor și coloanelor acestui 

tabel. Numerotarea găurilor se face în ordinea în care acestea au fost selectate. Tabelul poate fi așezat 

și mutat oriunde în spațiul de lucru (7), iar o serie de proprietăți pot fi modificate din meniul 

contextual prin opțiunea Properties. 

a bComanda Hole Comanda Thread/Tap
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Figura 6.30 

 

Cosmetizarea cotelor 

 După ce a adăugat o cotă în desenul de execuție, proiectantul poate opta pentru repoziționarea 

manuală a acesteia pentru a nu se intersecta cu alte cote sau pentru a evita situațiile în care cota 

respectivă nu este îndeajuns de vizibilă, fiind situată deasupra unor elemente ale desenului.  

 Repoziționarea cotelor se realizează cu ajutorul unor manipulatori săgeți (Move value, Move 

dimension line și Move dimension line secundary part), neactivați în mod implicit la deschiderea 

primei sesiuni de lucru în CATIA. Astfel, pentru activare, se accesează meniul Tools -> Options -> 

Mechanical Design -> Drafting -> Manipulators, așa cum se observă în Figura 6.31, în care 

proiectantul poate bifa manipulatorii pe care îi dorește activi. 

 

Figura 6.31 

 Pentru a repoziționa o anumită cotă se folosesc cele două săgeți albe cu sens dublu, iar pentru a 

adăuga indicații se apasă pe triunghiurile roșii, pe ecran fiind afișată una din ferestrele de dialog Insert 

text before sau Insert text after. Odată introdus textul, acesta este afișat în dreptul cotei 

corespunzătoare, având rolul de a oferi informații suplimentare (exemplu, 4 găuri Ø12 dispuse 

echidistant). 

 Modalitatea de poziționare a cotei se stabilește din meniul contextual al respectivului port de 

vedere, opțiunea Properties, tab-ul Dimension line. Tot din acest tab proiectantul stabilește și forma 

săgeților cotelor, Figura 6.32. 

 Din tab-ul Value se alege orientarea valorii cotei având ca referință linia de cotă, ecranul sau 

vederea curentă. Astfel, în unele cazuri, este necesar ca valoarea cotei să fie dispusă perpendicular pe 
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linia de cotă, paralel cu aceasta, sau înclinată cu un anumit unghi. Indiferent de orientare, valoarea 

cotei se înscrie relativ la linia de cotă în funcție de câmpul Offset. Pentru a stabili formatul și precizia 

cotei respective se completează câmpurile din zona Format, Figura 6.33. 

 

 

Figura 6.32 

 

Figura 6.33 

6.5.  Notarea stării suprafețelor 

 În procesul de obţinere a suprafeţelor unei piese, prin diferite procedee tehnologice (strunjire, 

frezare, turnare, forjare etc.), acestea (suprafeţele) rezultă cu mici asperităţi, uneori neobservabile cu 

ochiul liber. Ansamblul acestor microneregularităţi ale suprafeţei rezultate în urma unui proces 

tehnologic se numeşte rugozitate.  
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 Rugozitatea suprafeței se exprimă prin unul sau mai mulți parametri conform standardul SR ISO 

4287: 2000 exprimați în micrometri (Ra – abaterea medie aritmetică a profilului, Rz – înălțimea 

neregularităților în 10 puncte alese arbitrar, Ry – înălțimea maximă a profilului etc.). 

 Starea suprafeţelor indicată pe desen reprezintă starea finită a suprafeţelor (inclusiv tratamente 

termice şi termochimice, acoperiri metalice etc.), înainte de vopsire şi lăcuire. 

 Simbolurile utilizate pentru indicarea rugozităţii suprafeţelor sunt prezentate în SR EN ISO 

1302:2002. Se poate utiliza simbolul de bază ,Figura 6.34 (a); simbolul din (b) se foloseşte când 

îndepărtarea de material este obligatorie; simbolul din (c) se foloseşte atunci când se interzice 

îndepărtarea de material. Acest simbol se foloseşte şi pe desenele de operaţii pentru a arăta că o 

suprafaţă trebuie să rămână în aceeaşi fază ca la operaţia precedentă; dacă trebuie să fie indicate 

caracteristicile speciale ale suprafeţei atunci la braţul cel mai lung al simbolului de bază se 

completează cu o linie ca în (d); dacă pentru toate suprafeţele piesei este cerută aceeaşi stare a 

suprafeţei, atunci se foloseşte simbolul din Figura 6.34 (e). 

 

Figura 6.34 

 Simbolul grafic trebuie utilizat o singură dată pe o suprafaţă şi, de preferat, pe proiecţia unde 

figurează cota care defineşte suprafaţa sau poziţia acestei suprafeţe. 

Inserarea rugozităților pe desen (Roughness Symbol) 

 Pentru a înscrie rugozitatea pe anumite suprafețe ale piesei, se consideră parametrul de profil Ra, 

indicând suprafața și valoarea sa, cu ajutorul comenzii Roughness Symbol aflată pe bara de 

instrumente Annotations, Figura 6.35. 

 

Figura 6.35 

 

Comanda Text With Leader 

 Pentru a adăuga o adnotare pe desenul de execuție se utilizează comanda Text With Leader de pe 

bara de instrumente Annotations. Adnotarea prezentată în Figura 6.36 este necesară pentru a informa 

utilizatorul desenului de execuție asupra faptului că sunt 4 găuri cu diametrul Ø6 echidistant pe 

circumferință unui cerc. 
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Figura 6.36 

 

6.6.  Notarea pe desen a abaterilor dimensionale și geometrice 

 Precizia dimensională absolută a pieselor nu poate fi obținută prin procedeele tehnologice 

cunoscute, realizându-se piese cu abateri dimensionale, care reprezintă o precizie relativă 

dimensională a pieselor.  

 Precizia relativă de execuție stă la baza interschimbabilității pieselor. Fabricarea unor piese cu 

același fel de abateri dimensionale permite fabricarea pieselor de schimb, iar loturile de piese cu 

aceeași abatere asigură montajul în producția de serie. 

 Abaterile dimensionale – toleranțele – se înscriu pe desenul de execuție în vederea stabilirii 

tehnologiei de prelucrare.  

Inserarea toleranţelor liniare și unghiulare pe desen  

 Pentru a adăuga condițiile de toleranță (+0,1) se selectează fiecare cotă în parte, din bara de 

instrumente Dimension Properties, în câmpul Tolerance Description se alege Tol_Num2, apoi în 

câmpul Tolerance se înscrie valoarea +-0,10, Figura 6.37 (2a). Înscrierea toleranțelor se mai poate 

efectua pentru fiecare cotă în parte din meniul contextual al acesteia. În Figura 6.37 (2b) este afișată 

fereastra de dialog Properties, tab-ul Tolerance, în care apar câmpurile Upper Value și Lower Value. 

 

Figura 6.37 

 

Notarea pe desen a abaterilor geometrice 

 Datorită impreciziei inevitabile la prelucrare apar abaterile de la forma geometrică ideală, cea 

proiectată, a pieselor. Având în vedre rolul funcțional al piesei, aceste abateri de formă geometrică și 

de poziție reciprocă a suprafețelor trebuie păstrate în anumite limite, care sunt reglementate prin 

standarde. Toleranțele de formă geometrică și de poziție se înscriu pe desene numai dacă sunt 

necesare pentru asigurarea interschimbabilităţii pieselor respective. 
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 Toleranţa geometrică aplicată unui element defineşte zona de toleranţă în interiorul căreia trebuie 

să fie cuprins elementul respectiv. 

 Zona de toleranţă este suprafaţa sau spaţiul cuprins în interiorul unui cerc (sau cilindru), între 

două cercuri concentrice (sau doi cilindri coaxiali), între două linii paralele (sau plane paralele) în 

interiorul unui paralelipiped. 

 Elementul de referinţă este un element real al unei piese (muchie, suprafaţa unui alezaj) care este 

utilizat pentru determinarea poziţiei unei baze de referinţă. 

Inserarea toleranţelor geometrice pe desen (Geometrical Tolerance) 

 În Figura 6.38 este exemplificat modul în care se inserează pe desen toleranțele geometrice. 

Prima dată s-a adăugat o bază de referință A în interiorul alezajului central, s-a utilizat comanda 

Datum Feature (1). Suprafața cilindrică cu diametrul de 70mm are o toleranță geometrică de 

concentricitate de 0,01mm față de baza de referință A, a fost utilizată comanda Geometrical Tolerance 

(3) iar în fereastra acestei comenzi s-au completat câmpurile pentru Tolerance și Reference, iar apoi s-

a ales simbolul caracteristic concentricității. 

 

Figura 6.38 
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6.7.  Aplicaţii prezentate 

Exemplul 6.1 

 
Link-ul exemplului 6.1 

 

Exemplul 6.2 

 
Link-ul exemplului 6.2 

 

 

 

 

 

 

 

https://drive.google.com/drive/u/0/folders/1v1AqTIb41ENDrEmQq_U-eJ63iW6zo0TW
https://drive.google.com/drive/u/0/folders/1kCVNm9RSUkptghBp1H3WtbqI1Bdy_60L


 

110 

 

Exemplul 6.3 

 
Link-ul exemplului 6.3 

 

 

 

https://drive.google.com/drive/u/0/folders/1eHw6wKtHBfC-OW3DVh2oIpbD5qKG_URX
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